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INTRODUCCIÓN 

Las redes de cómputo de las organizaciones, se vuelven cada vez más complejas 

y la exigencia de la operación es cada vez más demandante. Las redes, cada vez 

más, soportan aplicaciones y servicios estratégicos de las organizaciones. Por lo 

cual el análisis y monitoreo de redes se ha convertido en una labor cada vez mas 

importante y de carácter pro-activo para evitar problemas. 

Anteriormente, cuando no se disponía de las herramientas que hoy existen, era 

necesario contratar a una empresa especializada para esta labor, con un costo 

muy elevado. Las herramientas hoy en día ofrecen varias empresas, le permiten, 

a una persona sin muchos conocimientos realizar esta importante labor, y contar 

un sistema experto como aliado que le ayuda en la interpretación de los 

resultados obtenidos. 

En éste contexto la Dirección de Sistemas  de información y Comunicaciones del 

Ejército Ecuatoriano (DISICOM) como el ente principal en las comunicaciones de 

Ejército Ecuatoriano, se encuentra empeñada en optimizar todos los servicios que 

presta, por tal razón es muy necesario que dispongan de una o varias 

aplicaciones de monitoreo de redes, con la finalidad de precautelar el correcto 

funcionamiento de la red. 

En respuesta a los requerimientos de la DISICOM, que ha tenido la necesidad de 

contar con potentes herramientas informáticas para optimizar el control y 

administración de sus redes, ésta entidad está interesado en testear aplicaciones 

de monitoreo de redes para comparar sus ventajas y desventajas frente a otras 

aplicaciones que actualmente tienen operando.  

Entre muchas de las aplicaciones de monitoreo de redes se encuentran 3Com 

Supervisor y 3Com Network Director; dos aplicaciones de la marca 3Com de las 

cuales se ampliara más adelante; estas dos aplicaciones pertenecen a un mismo 

tipo de software pero orientado a dos mercados diferentes; mientras que 3Com 

Network Supervisor está orientado a usuarios comunes que no demandan de 

mayores requerimientos; 3Com Network Director está orientado a empresas y 
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grandes instituciones que demandan de funciones adicionales. Es decir, Network 

Supervisor es un software básico que sirve para monitorear redes y conexiones y 

administrar ciertos dispositivos switch, y Network Director es un software con 

funciones avanzadas de administración que abarca las tareas que realiza Network 

Supervisor y amplía sus funciones.  

Sin embargo, una vez realizado algunas pruebas de escritorio se ha comprobado 

que las dos aplicaciones tienen ciertas desventajas en su uso, ya que al ser una 

marca de 3Com tiene total compatibilidad con dispositivos de esta casa comercial, 

mientras que para una gran parte de dispositivos de otras marcas no tienen 

soporte. 

El presente trabajo pretende servir de una guía para las personas interesadas en 

testear y probar las características de la aplicación. 
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CAPÍTULO I 

SUPERVISOR DE RED 

1.1. GENERALIDADES 

¿QUÉ ES EL 3COM NETWORK SUPERVISOR? 

El 3Com Network Supervisor (3ComNS) es una aplicación de administración de 

redes fácil de usar que descubre, asigna y muestra gráficamente conexiones de 

redes y dispositivos IP, incluyendo teléfonos IP 3Com® y algunos populares 

productos de otros fabricantes. 

Asigna dispositivos y conexiones para que se puedan supervisar con facilidad los 

niveles de tensión, establecer umbrales y alertas, ver eventos de red, generar 

informes en formatos definidos por el usuario e iniciar herramientas de 

configuración de dispositivos. Lo que es más, cuando cambia la red, puede indicar 

a 3Com Network Supervisor que regenere un evento con una alerta que indique el 

suceso anormal que está ocurriendo en la red. 

Las operaciones automatizadas, los valores predeterminados inteligentes, la 

capacidad de detectar las configuraciones incorrectas de la red y la oferta de 

sugerencias de optimización convierten a esta aplicación en la herramienta ideal 

para administradores de red de todos los niveles de experiencia. 

Esta aplicación ofrece varios servicios, los más importantes son: 

 Descubre y administra hasta 1.500 dispositivos IP y hasta 1.500 teléfonos 

IP de 3Com. 

 Admite redes que utilizan varias protocolos de comunicación 

 Para ayudar a resolver rápidamente los problemas, un motor de eventos 

inteligente detecta automáticamente y clasifica eventos en diferentes tipos de 

severidad. 
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 El envío de alertas por correo electrónico, buscapersonas o mensajes SMS 

permite a los administradores estar en contacto con la red aunque estén lejos 

de la consola de administración; la aplicación también puede enviar mensajes 

SNMP traps a otros sistemas de administración de red, como HP OpenView. 

 Presenta un mapa de red agrupado por subred IP o como una vista plana de 

Nivel 2 de toda la red 

 Optimiza y resuelve los problemas de la conectividad de nodo-extremo 

rastreando las rutas entre dos nodos cualquiera en la red 

 La interfaz gráfica ayuda a los administradores configurar fácilmente los límites 

de detección de dispositivos durante el proceso de descubrimiento de red.
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1.2. PRINCIPALES COMPONENTES DE LA APLICACIÓN 

1.2.1. VENTANA PRINCIPAL 

La ventana principal de 3ComNS es el área de trabajo de la aplicación donde 

están las barras de herramientas, accesos directos, mapa de red y todas las 

funciones disponibles. 

1.2.1.1. Componentes de la ventana principal: 

 Mapa de red. Provee una representación gráfica de la topología de la red 

descubierta. En ella muestra los dispositivos existentes en la red, diferenciado 

mediante gráficos distintos para cada dispositivo en particular. 

 Nota: Sólo un mapa de red puede ser abierto a la vez, abrir un nuevo mapa 

cerrará el actual. Los archivos de mapa de red tienen extensiones .map. 

 Árbol. El árbol despliega los dispositivos dentro de la red, agrupados por 

subredes y grupos de dispositivos. 

 Barra de herramientas. La barra de herramientas provee acceso a las 

funciones más comunes utilizadas en la navegación y administración del mapa 

de red. 

 Barra de estado. La barra de estado provee información detallada acerca de 

los ítems o dispositivos seleccionados dentro del mapa y el árbol de red, e 

información referente a la barra de menús. 

 Menú principal. El menú principal contiene todas las funciones y 

características disponibles en la aplicación, con los accesos directos mediante 

la combinación de teclas. Desde el menú principal se puede acceder a 

cualesquier función disponible ingresando a los menús correspondientes: 

archivo, edición, vista, dispositivo, monitoreo, alertas/eventos, herramientas, 

ayuda. 
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1.3. DESCRIPCIÓN DE LA APLICACIÓN 

1.3.1. PROCESO DE DESCUBRIMIENTO DE LA RED 

Antes de utilizar 3ComNS es necesario realizar un descubrimiento de la red, para 

conocer la topología, número de dispositivos, conexiones, subredes, etc.; 

información necesaria para que la aplicación pueda iniciar el monitoreo y 

administración de la red. 

El descubrimiento de red está dividido en tres procesos básicos que se describen 

a continuación: 

 Detección de dispositivos 

 Determinación de la topología 

 Redescubrimiento de la red 

1.3.1.1. Detección de dispositivos 

Esta operación determina cuantos dispositivos existen en una determinada subred 

y permite obtener información total referente a los dispositivos encontrados. Con 

la información básica de las primeras direcciones IPs localizadas, crea una lista 

de posibles subredes a ser descubiertas dentro de éste rango de IPs, 

posteriormente determina las subredes existentes y localiza todos los dispositivos 

existentes dentro de éste rango de direcciones, hasta concluir con todas las 

posibles subredes que pueden existir dentro de una determinada red. 

Es posible controlar la búsqueda de dispositivos dentro de un rango específico de 

direcciones, pero ello se debería realizar únicamente cuando se conoce 

previamente la dirección IP de la subred que se pretende descubrir. 

Durante la detección de los dispositivos, la aplicación realiza los siguientes 

procesos internos: 

 IP Ping. Detecta los nodos de IPs que existen en la red.  
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 Detección de protocolos. Determina si el dispositivo detectado soporta 

ciertos protocolos: SNMP, HTTP y Telnet, etc. Generalmente se obtiene 

información más detallada de los dispositivos que soportan SNMP iniciando 

inmediatamente la comunicación con el dispositivo. 3ComNS detecta los 

protocolos HTTP y Telnet intentando abrir una conexión TCP para el 

dispositivo utilizando los puertos 80 y 23 respectivamente; el propósito de esta 

detección es decidir si habilitar el menú de opciones del clic derecho de HTTP 

y Telnet. 

 Detección de los dispositivos SNMP. Esta etapa aplica solo para los 

dispositivos que soportan SNMP descubiertos en la etapa anterior. 3ComNS 

lee el estándar SNMP MIBs, con la finalidad de determinar información 

adicional a cada nodo SNMP, en particular el tipo de dispositivo, sus 

direcciones IPs y sus direcciones MAC. Cuando un dispositivo tiene múltiples 

direcciones IPs que responden con la misma información, la aplicación intenta 

representar en el mapa como un solo dispositivo; sin embargo algunos 

dispositivos con múltiples direcciones IPs que responden con diferente 

información, inicialmente son detectados como dispositivos separados, y luego 

3ComNS intenta resolver en la etapa sizing. 

 Resolución de la dirección IP a MAC. En esta etapa se obtiene la dirección 

MAC de los nodos que no son compatibles con SNMP. Es muy importante 

obtener la dirección MAC de los dispositivos, ya que permite determinar la 

posición de los dispositivos en la topología de la red. 

 Reconocimiento de estaciones finales. En esta etapa el programa intenta 

determinar el sistema operativo que tienen instalados los dispositivos 

compatibles con SNMP reconocidos como PCs finales, mediante cuatro pasos: 

1. Intentando iniciar sesión con Telnet, siempre y cuando esté habilitado y/o 

exista soporte para éste servicio. 
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2. Determinando si los nodos están operando como un servidor de archivos, 

esto es posible intentando conectar al dispositivo por medio del protocolo 

TCP y puerto 2049. 

3. Determinando si el nodo está operando como un servidor de impresión, 

intentando conectar al dispositivo mediante TCP puerto 515. 

4. Usando Microsoft Windows API, desde donde se obtiene información sobre 

el sistema operativo, y si pertenece a un dominio o grupo. 

 Reconocimiento Web. Algunos dispositivos 3Com tienen interfaces de 

administración de Web (HTTP), pero no soportan SNMP; para estos 

dispositivos 3ComNS busca una etiqueta que es proporcionada en forma 

oculta por el dispositivo. 

 Resolución de nombres DNS. Durante esta etapa la aplicación intenta 

recuperar un nombre DNS para cada dirección IP que ha sido encontrada, 

luego usa información del registro de Windows con el propósito de establecer 

la existencia de servidores DNS y se comunica con estos dispositivos 

utilizando consultas UDP. 

 Detección de dispositivos VOIP.  Obtiene información detallada de 

dispositivos VOIP, en caso de que existan. Este paso es importante porque 

algunos de estos tipos de dispositivos no soportan SNMP, ya que muchos de 

ellos no tienen dirección IP y no responden a un “ping”; por lo cual serán 

marcadas solamente con la dirección MAC. 

 Detección de dispositivos VCX (SIP). En esta etapa la aplicación obtiene 

información detallada de dispositivos VCX descubiertas. Entre estos 

dispositivos están los siguientes: VCX Gateway and Server y VCX Phones. 

 Determinando la cantidad de dispositivos (Device Sizing). En la etapa final 

de descubrimiento son incluidos detalles adicionales de los dispositivos; es 

decir se obtiene información detallada de configuración, tales como: número 
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de dispositivos encontrados, tipo de software y la versión, el tipo y número de 

puertos en cada unidad, la forma de enlace y las VLAN‟s configuradas. 

Esta etapa se realiza una vez que se hayan ejecutado todas las demás etapas 

en las subredes descubiertas; debido a que algunos dispositivos que tienen 

múltiples direcciones IPs, intenta representar como un solo dispositivo en el 

mapa de red, con toda la información obtenida durante el proceso de 

descubrimiento. 

1.3.1.2. Determinación de la topología 

El objetivo de la segunda parte del proceso de descubrimiento es determinar la 

topología de red, estableciendo conexiones entre los diferentes dispositivos que 

han sido descubiertos y para determinar cómo están físicamente conectados.  

Las principales etapas necesarias para determinar la topología de red son las 

siguientes: 

 Sizing. La información de los dispositivos proporcionado en el proceso de 

descubrimiento, en especial el número de puertos existentes en los 

dispositivos switches, es utilizado para determinar sí los dispositivos 

descubiertos son soportados por 3ComNS, y de esta manera determinar la 

topología de red. Los dispositivos de otros fabricantes diferentes a 3Com, 

también se muestran dentro de la topología, sin embargo puede que la 

información proporcionada no sea detallada ni precisa. 

 Expansión del árbol de red. Habiendo obtenido una lista de switches 

soportados, esta etapa intenta determinar aquellas conexiones entre 

dispositivos. Esta etapa es una extensión del “Device Sizing” pero la 

información obtenida es utilizada solamente para establecer la topología. 

 Sondeo remoto (broadcast ARP). Ésta etapa tienen como propósito intentar 

forzar a que cada switch aprenda las direcciones de otros switches en la 

misma subred; para ello se utiliza un sondeo remoto para ordenar a cada 
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switch que solicite respuesta (ping) a una dirección no usada de la red, 

forzándolo a transmitir un broadcast ARP, esto causa que otros switches en la 

subred aprendan las direcciones de origen del switch. 

 Identificación de PCs finales. En esta etapa se identifican a los puertos que 

tienen solamente una dirección IP, con el propósito de determinar la existencia 

de PCs finales. 

 Resolución de dispositivo. Durante esta etapa 3ComNS intenta establecer 

cuales switches han aprendido las direcciones de otros switches y que puertos 

han sido utilizados. 

  Sondeo remoto (direct PINGs). Si no ha obtenido suficiente información en 

la etapa de resolución de dispositivos, nuevamente forzará a aprender la 

dirección de otros dispositivos, ordenándolos a realizar un ping a cada 

dispositivo. 

 Construcción del árbol. En esta etapa, 3ComNS analiza toda la información 

obtenida en las etapas anteriores, para construir una vista de árbol de las 

subredes, colocando los PCs apropiadamente en el mapa de red. 

 Topología desconocida (clouds). Cuando 3ComNS construye el árbol de 

red, en ciertas partes de la red, no es posible determinar su topología. En 

estos casos el mapa mostrará una nube, que típicamente representan 

direcciones de múltiples dispositivos que no pueden comunicarse entre ellos y 

ni tampoco pueden ser gestionados; también pueden representar una pérdida 

de comunicación. 

1.3.1.3. Redescubriendo la red 

Cuando 3ComNS realiza la primera operación de descubrimiento, toda la 

información obtenida representa en el mapa de red. También se puede dar 

instrucciones a 3ComNS realizar descubrimientos adicionales (redescubrimiento), 

por las siguientes razones: 
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 Pueden existir subredes adicionales que no estaban especificadas o no 

existían en el momento que se realizó el proceso de descubrimiento. 

 Nuevos dispositivos pueden haber sido añadidos a la subred, o algunos 

dispositivos pueden haber cambiado la configuración. 

Una vez que realiza el redescubrimiento, no actualiza automáticamente el mapa 

de red, sino que guarda en una base de datos temporal hasta que complete la 

operación, pero se puede continuar trabajando en el mapa actual, con ciertas 

restricciones en algunas tareas. Una vez completada la operación de 

redescubrimiento actualiza la base de datos y el mapa de red con la nueva 

información descubierta.  

Las reglas básicas que se aplican en la actualización de datos son los siguientes: 

 Nuevas subredes son simplemente añadidos en las redes descubiertas 

inicialmente. 

 Nuevos dispositivos son añadidos a sus respectivas subredes. 

 Algunos dispositivos que han cambiado son actualizados. 

 Dispositivos que han sido removidos o no responden en el segundo 

descubrimiento, no son borrados de la base de datos ni del mapa, excepto 

cuando la dirección IPs ha sido asignado a otro dispositivo. 

 Las nuevas conexiones encontradas son añadidos a la red. 

 Si anteriormente un puerto fue el enlace de un dispositivo, y ha sido conectado 

a otro dispositivo, éste será eliminado. 

 Si un puerto ha perdido comunicación, éste enlace no será borrado, sino 

marcado como una conexión truncada. 
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1.3.1.4. Asistente de descubrimiento de red 

Para realizar el proceso de descubrimiento de la red es necesario utilizar 

herramientas necesarias para realizar el proceso de descubrimiento de la red, 

mediante asistentes y cuadros de diálogos. 

El asistente de descubrimiento de red es una guía paso a paso para iniciar el 

proceso de descubrimiento.  En caso de que ya exista un mapa de red creada, se 

puede utilizar este proceso para hacer un redescubrimiento de una parte o 

nuevamente de toda la red. 

El asistente se puede ejecutar desde diferentes lugares de la aplicación:  

 Cuadro de diálogo de bienvenida. Al inicio de la aplicación se presenta el 

cuadro de diálogo de bienvenida iniciamos el asistente dando clic en Create a 

network map. 

 Desde el menú principal, seleccionando file>new lanzamos el asistente que 

permitirá crear el nuevo mapa. 

 Desde el menú principal se puede ejecutar el asistente seleccionando 

tools>network discovery  

Existen tres formas de configurar el proceso de descubrimiento: 

 Sin seleccionar una subred. Ejecutando el asistente sin seleccionar una red 

del mapa, lleva a un cuadro de diálogo sin ningún dato; es decir que la 

búsqueda de la red se realizará desde el inicio y con datos proporcionados en 

ese momento por el usuario. 

 Seleccionando una subred descubierta. Al ejecutar el asistente, seleccionando 

previamente una red descubierta, en el cuadro de diálogo muestra la subred 

seleccionada, para luego continuar con la configuración de la búsqueda. 
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 Seleccionando una red no descubierta. Cuando se ha realizado previamente 

una operación de descubrimiento de red, y el programa ha detectado la 

presencia de un router, probablemente el mapa mostrará una subred no 

descubierta (undiscovery) como se muestra en el gráfico; estas redes 

probablemente son aquellas que se encuentran directamente fijadas al router y 

no han sido especificadas en el primer descubrimiento.  

Gráfico No. 1-2: Red no descubierta 

 

En caso de seleccionar una de estas subredes, el asistente de descubrimiento 

de red lanzará el cuadro de diálogo con la información de la subred que 

también puede modificarse. 

1.3.1.4.1. Especificar subredes 

Este panel es el primer cuadro de diálogo que muestra el asistente de 

descubrimiento de red, que permite especificar una o más subredes que se desea 

descubrir. 

Gráfico No. 1-3: Configurar descubrimiento de  subredes 
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Los principales botones que muestra la ventana, tienen las siguientes funciones: 

 Add... Este botón lanza un cuadro de diálogo donde se realiza la configuración 

de la subred, determinando la dirección IP y la máscara de subred. Así mismo, 

en esta ventana se puede especificar direcciones IPs de inicio y de fin que 

limitará el proceso, descubriendo sólo los dispositivos que se encuentren 

dentro del rango especificado; o seleccionando la opción Discovery full range 

para buscar dentro de toda la subred. 

Gráfico No. 1-4: Agregar subredes en el asistente 

 

 Edit… Este botón permite editar los detalles de la subred seleccionada en la 

lista, desplegando la misma ventana explicada en el párrafo anterior. 

 Remove… Elimina una subred seleccionada; pero no elimina del mapa. 

 Add local subnets. Permite añadir la subred local, en la cual se encuentra 

ejecutando 3ComNS. 

 Find subnets. Intenta localizar subredes que se encuentran en comunicación 

con un router específico, que podría ser el actual o cualquier otro. 
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 Import / export subnets. Se puede exportar e importar la configuración de 

una o varias subredes en un archivo con extensión .subnets o .tsv. 

1.3.1.4.2. Monitorear dispositivos y conexiones 

En este paso el asistente permite configurar la manera como serán controlados 

los dispositivos por la aplicación, cuando el proceso de descubrimiento haya 

terminado y el mapa de red esté actualizado. El cuadro de diálogo tiene dos 

opciones: 

Gráfico No. 1-5: Monitoreo de dispositivos y conexiones 

 

Si selecciona Yes, el monitoreo de los dispositivos encontrados iniciará 

inmediatamente después de haber terminado el proceso de descubrimiento. Por 

el contrario, si selecciona No el control de los dispositivos no iniciará. Sin embargo 

después se puede seleccionar un dispositivo e iniciar el monitoreo. 

1.3.1.4.3.  Configuración de SNMP 

En este paso el asistente permite especificar la configuración para utilizar los 

dispositivos, mientras intenta descubrirlos. 
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Gráfico No. 1-6: Configuración de SNMP 

 

Por razones de seguridad, es preferible utilizar la configuración predeterminada 

de los dispositivos SNMP, de lo contrario debería configuración esta ventana. 

1.3.1.4.4. Dispositivos NBX Voice Network 

En este paso el asistente pregunta si existen sistemas de voz NBX en la red, y 

especialmente en la subred que está a punto de ser descubierta por la aplicación. 

1.3.1.4.5. Procesador de llamadas NBX 

Éste cuadro de diálogo se presenta solo si en el panel anterior seleccionó la 

opción Yes, aquí se realiza la configuración del usuario y contraseña del 

procesador de llamadas NBX; cabe recordar que estos dispositivos no soportan 

protocolo SNMP solamente administración de Web (HTTP). 

Por último el asistente, presenta un resumen de la configuración, e inicia el 

proceso de descubrimiento de la red, presentando una barra de progreso hasta el 

término del proceso. 
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1.3.1.5. Reporte de descubrimiento 

El reporte de descubrimiento de red, se presenta una vez termina 

satisfactoriamente la tarea. El proceso está divido en dos etapas principales. 

 Descubrimiento. En éste paso la aplicación presenta una lista de los 

problemas presentados en el descubrimiento de dispositivos, este proceso se 

repite para cada sección de red y subredes encontradas y se presentan 

reportes por separados. 

 Topología. En ésta segunda etapa, presenta los problemas encontrados en el 

descubrimiento de conexiones; por cada subred intenta determinar la topología 

que forman los dispositivos. 

1.3.2. ÁRBOL Y MAPA DE RED 

Ésta sección describe el funcionamiento del mapa y el árbol de red en la 

aplicación. Es necesario describir brevemente algunos conceptos que serán 

enunciados frecuentemente. 

 Nodos. Un nodo es cualquier objeto en el mapa que representa una entidad 

física. Por ejemplo: Dispositivos (switch, router, puente), estación final (PCs, 

servidores, etc.) y teléfonos VOIP,. 

 Subredes. Es una sección de red, donde los dispositivos tienen una dirección 

IP dentro de un rango definido. 

 Grupos de dispositivos. Representa uno o más dispositivos agrupados. 

 Nubes. Corresponde a un área del mapa de red que 3ComNS carece de 

información de la topología. 

 Conexiones. Representa una conexión física entre dos nodos de la red. 

 Conexión de capa 3. Representa una conexión lógica entre un router o switch 

de capa 3 y una subred. 
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1.3.2.1. Mapa de red 

El mapa se muestra en la parte derecha de la pantalla principal del programa, y es 

la representación gráfica de la topología de red descubierta. 

Gráfico No. 1-7: Mapa de red 

 

La representación gráfica consiste en íconos que representan los dispositivos, 

subredes y otros componentes de la red, las líneas entre los íconos representan 

conexiones entre dispositivos. 

Las siguientes tablas muestran la descripción de los íconos usados en el mapa. 
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Tabla No. 1: Íconos utilizados en el mapa de red 

Ícono Descripción 

 

Un rombo, representa un router o un switch de capa 3, la 
imagen dentro del rombo indica el tipo de router o switch de 
capa 3. 

 

Un octágono, representa un dispositivo de red como: switch, 
hub, wireless access point, processor call (procesador de 
llamadas), la imagen dentro del octágono indica el tipo de 
dispositivo. 

 

Representa los componentes de un XRN switching Fabric, 
agrupado dentro de un solo ícono en el mapa. 

 

Un cuadrado, representa otros dispositivos encontrados en la 
red, tales como: PCs, servidores, y teléfonos IP. También 
incluye dispositivos que no han podido ser descubiertas 
completamente, por ejemplo cuando 3ComNS no ha podido 
determinar la dirección IP de un dispositivo. La imagen dentro 
del cuadro indica el tipo de dispositivo. 

 

Un triángulo representa al computador donde está instalado y 
ejecutándose 3Com Network Supervisor, la imagen dentro del 
dispositivo indica el tipo de computador y el sistema operativo 
instalado. 

 

Una nube aparece en un mapa de red, por dos razones: 

 Representa una sección de la red, cuando 3ComNS no 

puede determinar la topología por falta de información 

disponible. 

 Muestra un número de clientes conectados a cada Access 

Point descubierto en el proceso. 

 Cuando existe un problema de comunicación en la 
comunicación. 
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Un círculo representa una subred dentro de la red, la etiqueta 
en el centro del círculo muestra la dirección de la subred. Si la 
subred no ha sido aún descubierta en la etiqueta muestra el 
texto “Undiscovered”. 

 

3ComNS permite agrupar dispositivos juntos y relacionados 
dentro de un grupo de dispositivos; cada grupo representado 
por una nube dentro de un rectángulo  

  

Tabla No. 2: Íconos para dispositivos telefónicos 

Ícono Descripción 

 

Procesador de llamadas NBX 

 

Tarjeta de línea telefónica 

 

Adaptador de terminal análogo 

 

Teléfonos NBX y consola de asistente 

 

Aplicaciones NBX (pcXset and 

ConneXtions) 
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Tabla No. 3: Íconos para conexiones 

Línea Descripción 

 
Representa una conexión agregada. 

 

La conexión está operando en “Full duplex mode” (Doble 
sentido) 

 

La conexión está operando en “Half duplex mode” (Una sola 
dirección) 

 

Representa una conexión que es parte de una conexión 
fuerte. 

 

La conexión ha sido debilitada. 

1.3.2.2. El árbol 

El árbol se muestra en la parte izquierda de la ventana principal de 3ComNS y 

enlista todos los dispositivos que han sido descubiertos en la red; agrupados 

dentro de subredes y grupos de dispositivos. 

Gráfico No. 1-8: Árbol de red 

 

Cada dispositivo aparece una sola vez dentro del árbol. Routers y switch de capa 

3; generalmente aparecen en la parte superior del árbol, otros dispositivos se 
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muestran dentro de las subredes apropiadas y grupos de dispositivos. Las 

subredes que aún no han sido descubiertas aparecen con el texto Undiscovered 

1.3.2.3. Estructura del mapa y árbol de red 

El mapa y árbol de red tienen dos vistas básicas de la topología (red agrupada y 

no agrupada), dentro del cual se puede navegar alrededor del mapa o del árbol. 

1.3.2.3.1. Red agrupada 

En la vista predeterminada muestra los dispositivos en la red lógicamente 

agrupada por direcciones de IPs de la subred. Esta vista es jerárquica y se ordena 

de arriba hacia debajo de la siguiente manera: 

 Nivel más alto del mapa. Este mapa presenta dispositivos de capa 3, 

mostrando routers y switches de capa 3, conexiones entre ellos y las 

direcciones  IPs de las subredes que están lógicamente conectados. También 

pueden mostrarse grupos de routers y switches de capa 3. 

 Submapas. Es una agrupación lógica de los dispositivos de red. Existen dos 

tipos de submapas. 

o Subredes. Son creadas automáticamente por 3ComNS durante el proceso 

de descubrimiento de la red y permiten ver la red agrupados por la 

dirección IP de la subred. Cada subred contiene todos los dispositivos 

relacionados con esa dirección IP. 
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Gráfico No. 1-9: Mapa agrupada en subredes 

 

o Grupos de dispositivos. Permite agrupar a dispositivos similares y 

representar el mapa de forma más intuitiva. 

Gráfico No. 1-10: Mapa agrupado por grupos de dispositivos 
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1.3.2.3.2. Red no agrupada 

Con esta vista 3ComNS muestra la capa 2 (física) de la topología de red en un 

solo nivel, mostrando en el mapa todos los dispositivos descubiertos en la red. 

Este tipo de vista no muestra subredes ni grupos de dispositivos. 

 Subredes. No se muestran las conexiones de routers y dispositivos de capa 3 

a las subredes que están lógicamente conectadas. Los dispositivos se 

muestran en un solo nivel superior. 

 Grupos de dispositivos. Los grupos de dispositivos dentro de la red son 

expandidas dentro de la vista, y los dispositivos que contienen son mostrados 

en un solo nivel superior. Se debe considerar que cada ícono en el mapa 

representa un dispositivo en la red. 

1.3.2.4. Actividades en el mapa y árbol de red 

En el mapa y árbol de red podemos realizar varias tareas mientras se navega 

entre los dispositivos encontrados. Las principales funciones se describen a 

continuación: 

1.3.2.4.1. Seleccionar dispositivos  

Para seleccionar dispositivos en el mapa y árbol de red, siga estos consejos: 

 Para seleccionar un dispositivo utilice un simple clic izquierdo del ratón. 

 Para seleccionar varios ítems en el mapa o árbol, mantener presionado la 

tecla <Ctrl> mientras se da clic en el dispositivo. También se puede 

seleccionar varios dispositivos contiguos en el mapa dibujando un rectángulo 

con clic izquierdo sostenido. En el árbol, se puede seleccionar varios ítems 

contiguos  dando clic izquierdo en el primer dispositivo, luego presionar y 

mantener presionado la tecla <Shift> y por último seleccionar con el ratón el 

último dispositivo. 
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 Para seleccionar todos los dispositivos del mapa, ir al menú principal Edit > 

Select All. 

1.3.2.4.2. Navegar por el mapa 

La aplicación permite ejecutar varias acciones en el mapa de red, mediante la 

barra de herramientas, menú principal o clic derecho en el mapa: 

 (Go Up). Subir de nivel en el mapa de red.  

Se accede desde la barra de herramientas o del menú principal View>Go Up. 

  (Zoom In). Amplía la imagen del mapa. 

Se ejecuta desde la barra de herramientas, desde menú principal 

View>Zoom>Zoom In o desde el menú contextual clic derecho sobre el mapa. 

 (Zoom Out). Reduce la imagen del mapa.  

Se lanza desde la barra de herramientas, desde menú principal 

View>Zoom>Zoom Out o desde el menú contextual clic derecho sobre el 

mapa. 

  (Fit to Page). Ajusta el mapa a la venta actual.  

Se accede desde la barra de herramientas, desde menú principal 

View>Zoom>Zoom In o desde el menú contextual clic derecho sobre el mapa. 

 (Find). Permite buscar dispositivos, conexiones y componentes  

telefónicos, utilizando criterios como: dirección IP, dirección MAC, tipo de 

dispositivo, número de producto, versión de software, etc.  
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Se accede desde la barra de herramientas, menú principal Edit>Find o desde 

el menú contextual clic derecho sobre el mapa. 

 Trace path. Es utilizado para localizar caminos físicos existentes entre dos 

dispositivos.  

Puede ser lanzado desde el menú principal Tools>Trace Path; previamente 

seleccionado dos dispositivos o ingresando los datos en el cuadro de diálogo 

una vez ejecutado esta función. 

1.3.2.4.3. Mostrar etiquetas en los dispositivos del mapa (Labels) 

Permite seleccionar el tipo de etiqueta que se mostrará en los dispositivos 

existentes en el mapa, la configuración afectará a todo el mapa y árbol. Para 

elegir la etiqueta deseada damos clic en View > Labels. 

Gráfico No. 1-11: Menú mostrar etiquetas en los dispositivos 

 

 Nombre personalizado (Custom Name). Permite mostrar el nombre 

personalizado que se ha colocado a cada dispositivo. 

Para colocar el nombre personalizado dar clic en el dispositivo y en el menú 

principal Device>Properties o dar clic derecho en el dispositivo y seleccionar 

Properties y en la caja de texto Custom Name ingresar el nombre deseado. 
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Gráfico No. 1-12 (a): Nombre personalizado de un dispositivo 

 

Gráfico No. 1-12 (b): Nombre personalizado de un dispositivo 

 

 Nombre de usuario (User name). Para teléfonos VOIP muestra el nombre de 

usuario asociado con el teléfono. 

 Resolución de nombres DNS. 3Com Network Supervisor automáticamente 

resuelve DNS Names para dispositivos que tienen configurado una dirección 

IP, usando el servidor DNS configurado en la computadora donde está 

corriendo 3ComNS. La resolución de nombres es realizado durante el proceso 

de descubrimiento de la red. 

 Nombre de sistema. Para ciertos dispositivos es el nombre asignado 

automáticamente por 3ComNS, algunos dispositivos en el mapa no muestran 

nombre de sistema. 

 Dirección IP. Muestra la dirección IP configurada en cada dispositivo o 

dirección de subred que ha detectado la aplicación. Para dispositivos que 
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representan múltiples subredes se muestra una lista de direcciones IPs. 

Algunos dispositivos que no tienen dirección IP, el ícono en el mapa no 

muestra ésta etiqueta. 

 Direcciones MAC. Muestra la primera dirección MAC en cada dispositivo del 

mapa de red, que ha descubierto la aplicación durante el proceso de 

descubrimiento. Algunos dispositivos no tienen direcciones MAC. 

1.3.2.5. Modificar el diseño del mapa 

1.3.2.5.1. Modificar manualmente 

Una vez que el proceso de descubrimiento de la red ha creado el mapa con todos 

los dispositivos y conexiones encontradas, 3ComNS permite modificar 

manualmente el diseño del mapa; es decir, se puede añadir dispositivos y 

conexiones que representan entradas lógicas o que no existen en el mapa; 

también se pueden eliminar ítems que no sean de interés. 

 Agregar ítems en el mapa. Dispositivos y nubes pueden ser agregadas 

desde el menú principal Edit>Add Items, el cual lanza el cuadro de diálogo de 

agregar, donde se selecciona el ítem deseado y se arrastra hasta el mapa. 

Gráfico No. 1-13: Ventana agregar ítems 
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Después de agregar ítems al mapa se puede configurar varios detalles 

correspondientes a cada ítem, dando clic derecho en el dispositivo y 

seleccionando Properties. 

 Agregar conexiones. Las conexiones pueden ser añadidas entre dos 

dispositivos; un dispositivo y una nube o entre dos nubes. 

Para agregar conexiones, seleccionar dos ítems del mapa que desea 

conectar, y seleccionar en el menú principal Edit > Add Link. 

Cuando una conexión es inválida, la línea en el mapa es entrecortada. Una 

conexión inválida puede darse cuando es añadido manualmente o durante el 

proceso de descubrimiento de una subred ha fallado la búsqueda de una 

conexión que existía previamente. 

Gráfico No. 1-14: Conexión inválida 

 

 Borrar ítems del mapa. Algunos ítems y conexiones pueden ser borrados del 

mapa seleccionando Edit > Delete. Una vez borrado un ítem o conexión se 

elimina de todas las subredes y mapas; solo es posible volver agregar un ítem 

realizando un proceso de redescubrimiento o seleccionando Edit> Add Map 

Ítem.  

Conexiones de capa 3 no pueden ser borrados del mapa; sin embargo al 

borrar una subred, todas las conexiones de capa 3 existentes dentro de la 

subred son borradas automáticamente del mapa. 

1.3.2.5.2. Modificar automáticamente 

Al realizar un rediseño automático del mapa, el programa intenta rediseñar el 

mapa ordenando en forma lógica los dispositivos del mapa. 
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Para acceder a esta función se da clic derecho en el mapa y seleccionar Relayout 

o en el menú principal View>Relayout. 

1.3.2.6. Crear, guardar y abrir mapas 

Cuando se ejecuta por primera vez la aplicación 3Com Network Supervisor, 

puede crear un mapa desde el cuadro de diálogo que lanza la aplicación; después 

se puede crear desde File>New; una vez ejecutado la creación de un nuevo mapa 

la aplicación lanza inmediatamente el primer cuadro de diálogo del proceso de 

descubrimiento que se explicó en párrafos anteriores. 

Para guardar un mapa que actualmente está abierto y se ha realizado cambios 

seleccione File>Save; si se desea guardar el mapa con otro nombre o en otra 

ubicación se puede realizar seleccionando File>Save As. La dirección 

predeterminada para guardar mapas generalmente es: C:\Archivos de 

programa\3Com\Network Supervisor\maps; es decir: Directorio de 

instalación\maps\my_maps. La dirección predeterminada se puede cambiar 

seleccionando el directorio deseado en Tools>Options. 

Para abrir un mapa seleccione File>Open. Sólo puede estar abierto un solo mapa 

a la vez, por lo cual al abrir un nuevo mapa, el actual se cerrará. 

1.3.2.7. Imprimir el mapa 

Para imprimir un mapa se debe seleccionar File>Print, donde se ejecuta el cuadro 

de diálogo de impresión; existiendo dos formas de imprimir el mapa actual. 

 Imprimir el área visible. Esta opción permite imprimir solamente el área 

visible en la ventana principal de la aplicación. 

 Imprimir el mapa entero. Permite imprimir el mapa completo, 

independientemente del área visible en la pantalla. 
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Gráfico No. 1-15: Cuadro de diálogo imprimir mapa 

 

1.3.3. INFORMACIÓN Y CONFIGURACIÓN DE DISPOSITIVOS 

En ésta parte del manual se describe como ver información detallada y realizar 

configuraciones a los dispositivos encontrados en el proceso de descubrimiento, 

utilizando el cuadro de diálogo Properties, que permite realizar algunas 

actividades: 

 Ver información detallada de los ítems en el mapa de red. 

 Especificar información personalizada, tales como nombres y comentarios 

para cada ítem. 

 Cambiar el protocolo de comunicación que 3Com Network Supervisor utiliza 

para un dispositivo individual, o varios simultáneamente. 

 Modificar la forma como se comunica 3ComNS con un dispositivo en particular 

o varios dispositivos simultáneamente. 

3ComNS despliega el cuadro de diálogo Properties (Propiedades) de los ítems 

soportados y no soportados por la aplicación, que incluye: nodos, subredes, 

grupos de dispositivos, nubes, conexiones, conexión de capa 3, etc., que utilizan 

el mismo cuadro de diálogo con ciertas diferencias en cada caso. 
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Gráfico No. 1-16: Cuadro de diálogo propiedades 

 

Las pestañas más comunes del cuadro de diálogo de propiedades se explican a 

continuación: 

 General. En esta pestaña, generalmente presenta información común 

respecto al ítem seleccionado, tales como: nombre, tipo información del 

sistema, etc.; también se puede configurar información relacionada al nombre 

personalizado y comentarios. 

 Addresses. Presenta la dirección IP y MAC para el ítem seleccionado, en 

caso de que el ítem tenga varias direcciones, presentará una lista. En 

dispositivos añadidos, es posible configurar la dirección IP. 

 Security. Muestra la protocolo de comunicación usada por el dispositivo. 
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 Power over Ethernet. Muestra información relacionada a la configuración de 

energía de Ethernet y el uso por parte del puerto y la conexión seleccionada. 

 Phone. Esta pestaña es exclusiva de los dispositivos telefónicos, que 

muestran información específica como: nombre de usuario, título del usuario, 

nombre del departamento, número de extensión y la ubicación. 

 Ports. Despliega información especial, referente a los puertos de los 

dispositivos conectados, tales como: velocidad de conexión, dirección IP.  

1.3.4. MONITOREO DE LA RED 

Monitorear el estado de los dispositivos y conexiones dentro de la red, permite 

identificar posibles embotellamientos o problemas en la red antes que causen 

mayores impactos, e inmediatamente sean asistidos para una pronta solución. 

1.3.4.1. Conceptos básicos 

1.3.4.1.1. Monitor 

Un monitor es un contador o indicador de estado para un dispositivo o conexión 

que recoge datos a cerca de uno de sus atributos, tales como el número de 

paquetes que un dispositivo ha enviado o si una conexión está intermitente. Un 

dispositivo o conexión puede tener múltiples monitores que proporcionan un 

cuadro completo de las condiciones que está experimentando la red. 

1.3.4.1.2. Monitoreo y generación de eventos 

El sistema de monitoreo es usado como el recurso principal para generar eventos. 

Cuando un monitor entra en un estado que indica una condición anormal de la 

red, registra un evento detallando la causa; dependiendo si el monitor también 

puede registrar detalladamente el estado de monitoreo inmediatamente después 

de haber sucedido; o puede guardarla para resolver el problema más tarde. Esta 

información puede ser usada inmediatamente o después para determinar la causa 

del evento y ayudar a determinar una solución. 
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1.3.4.1.3. Estado de monitoreo 

3ComNS indica el estado del monitor de cada dispositivo sondeado por medio de 

un color de fondo (rojo, amarillo y verde) en el ícono en el mapa y su respectivo 

nodo en el árbol. De forma similar presenta el estado de monitoreo de cada 

conexión monitoreada, cambiando el color de la línea que representa la conexión 

a los tres estados anteriores indicados. Esto permite realizar un vistazo del estado 

actual de la red, logrando identificar rápidamente posibles problemas. 

Tabla No. 4: Colores que representan el estado de monitoreo 

Color Descripción 

Rojo   Significa que existe un evento crítico o severo en los 
ítems que muestre de color rojo, que aun no ha sido 
resuelto. 

Amarillo  Indica que existe un evento grave sin resolver. 

Verde  Significa que no existen eventos sin resolver. 

Ninguno Ninguno Los ítem sin ningún color, indican que los dispositivos no 
están siendo monitoreadas. 

Nota. Cuando el mapa de red está agrupado por subredes, 3ComNS propaga el 

estado de monitoreo de los dispositivos, conexiones y submapas en forma 

jerárquica hacia arriba. Es decir, cada submapa es pintado con el color que indica 

el estado de monitoreo más crítico de los dispositivos, conexiones o submapas 

que contiene la subred. 

1.3.4.1.4. Técnicas de monitoreo. 

La aplicación utiliza varias técnicas para monitorear el estado de los dispositivos y 

conexiones dentro de la red; que en general puede clasificarse en activo (active 

monitoring) y pasivo (pasive monitoring). 

 Active Monitoring. El monitoreo activo, trabaja sondeando y recuperando 

datos desde un dispositivo. Una vez que el dispositivo ha sido sondeado, o 
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una vez que el dato ha sido recuperado desde el dispositivo, 3ComNS puede 

analizar los resultados para determinar el estado del dispositivo. 

Existen varios mecanismos usados para el Active Monitoring, entre ellos: 

realizando PING con IPs, recibiendo datos desde SNMP MIBs, y directamente 

chequeando servicios disponibles. 

 Passive Monitoring. El monitoreo pasivo, utiliza un dispositivo para 

monitorear su propio estado y envía mensajes no solicitados a 3ComNS cada 

vez que su estado cambia, proveyendo detalles del cambio. Este tipo de 

monitoreo utiliza SNMP para enviar estos datos. Es decir, el monitoreo pasivo 

solo envía datos cuando el estado del dispositivo cambia, esto significa que el 

tráfico en la red es menor al monitoreo activo. 

 IP Ping Monitoring. El monitoreo utilizando el comando Ping con la IP es la 

técnica más sencilla utilizado por la aplicación. En realidad es un monitoreo 

activo que trabaja enviando un mensaje ICMP y esperando el tiempo de 

respuesta del dispositivo, para determinar y actualizar el estado de monitoreo. 

 Service Polling. 3ComNS proporciona soporte para el estado de monitoreo de 

varios servicios que pueden ser proporcionados por servidores en la red, tales 

como: DNS, FTP, POP3 y correo SMTP. 3ComNS monitorea un servicio en 

conexión y envía una petición al servicio; la respuesta recibida, o al carecer de 

alguna respuesta sirve como información para que la aplicación actualice el 

estado del monitor. 

1.3.4.1.5. Ítems que soportan monitoreo 

Entre los ítems soportados para el monitoreo incluyen: 

 Dispositivos de infraestructura de red 

 Servidores 

 Estaciones finales 
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 Teléfonos VOIP 

 Conexiones Ethernet 

1.3.4.2. Ventana de monitoreo (live graphs) 

La ventana Live Graphs es la ventana principal de monitoreo, donde muestra el 

estado de los servicios que están ejecutándose en el ítem seleccionado. Para ver 

la ventana Live Graphs, seleccionar el ítem deseado y en el menú principal 

acceder mediante Monitoring>Live Graphs o dando clic derecho en el ítem y 

seleccionar Live Graphs. 

Gráfico No. 1-17: Ventana de monitoreo 

 

Cuando se abre la ventana Live Graphs para un dispositivo o conexión en 

particular, la aplicación incrementa la tasa de sondeo cada 10 segundos, 

proporcionando más detalles gráficos en el monitor. La tasa de sondeo para el 

monitor activo vuelve a su estado normal cuando haya cerrado la ventana Live 

Graphs. 

Monitores 

de 

servicios 

Gráficos 
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La pantalla Live Graphs muestra un gráfico para el estado de cada servicio del 

ítem seleccionado en el árbol. Cada entrada muestra el nombre del servicio 

monitoreado. El gráfico despliega un historial del estado monitoreado; por 

ejemplo, el monitor para el servicio IP PING despliega un gráfico historial del 

tiempo de respuesta para el dispositivo. 

Gráfico No. 1-18: Monitor para cada servicio 

 

Cada monitor tiene un umbral (banda) configurable que sirve para determinar un 

límite que se considere un estado de advertencia o de alto riesgo, y se representa 

con una línea de color amarillo y rojo respectivamente. Los umbrales 

generalmente son utilizados para generar eventos, por ejemplo si un monitor 

permanece sobre el límite de advertencia durante un tiempo largo, entonces 

generará un evento apropiado. 

Se puede acceder a más detalles de un monitor, dando clic derecho en la pantalla 

del gráfico o en el menú de herramientas de la ventana Live Graphs y 

seleccionando View>More detail (más detalles); se presenta un cuadro de diálogo 

donde detalla información y atributos del monitor seleccionado. Además, se puede 

cambiar el valor del umbral o deshabilitar el monitor eligiendo el botón adecuado. 
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Gráfico No. 1-19: Más detalles de monitoreo 

 

Para cambiar el valor del umbral dar clic en Change Thresholds y luego modificar 

la configuración del valor de sensibilidad, donde varía el umbral Warning y High 

que más adelante se explicará. 

Gráfico No. 1-20: Configuración de umbrales 

 



   

40 

 

1.3.4.2.1. Mensaje en la ventana Live Graphs 

El monitor de servicios de la ventana Live Graphs puede mostrar un mensaje en 

lugar del gráfico, debido a que la aplicación no dispone de información del estado 

del monitor; y puede darse por las siguientes razones: 

 Waiting. El monitor ha sido iniciado recientemente y está reuniendo los 

primeros datos que pueden determinar el estado del monitor; después de un 

corto periodo muestra el gráfico que representa el historial del estado del 

monitor. 

 switched Off. El monitor está deshabilitado y no dispone de datos que 

muestren su estado. 

 Data Unavailable. El monitor ha sido iniciado, pero no puede obtener datos 

necesarios para operar. Generalmente se presenta este comportamiento, 

cuando 3ComNS no puede autenticarse con el dispositivo o ha perdido 

comunicación con el dispositivo o conexión.  

1.3.4.3. Configuración 

1.3.4.3.1. Iniciar y detener el monitoreo 

Antes de que 3ComNS pueda generar eventos para los dispositivos de la red, es 

necesario iniciar el monitoreo de estos dispositivos, que puede realizarse 

automáticamente desde el proceso de descubrimiento de la red, o luego cambiar 

la configuración del monitoreo de dispositivos y conexiones con el fin de 

especificar los ítems más importantes a ser monitoreados y evitar demasiado 

tráfico en la red. 

Para iniciar el monitoreo del dispositivo, seleccionar el ítem deseado y dar clic en 

el menú principal Monitoring>Star Monitoring o también puede iniciar dando clic 

derecho en el dispositivo y seleccionando Start Monitoring del menú contextual. Si 

se selecciona subredes o grupos de dispositivos, la aplicación iniciará 
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recursivamente a monitorear todos los dispositivos y conexiones que contiene la 

subred o grupo de dispositivos. 

Para detener el monitoreo del dispositivo, proceder en forma similar, pero en esta 

ocasión seleccionar Stop Monitoring. 

1.3.4.3.2. Habilitar y deshabilitar monitores individuales de servicios 

Cada monitor provee detalles del estado de un atributo en particular del 

dispositivo o conexión. Si la información de un atributo particular no interesa 

puede deshabilitar este monitor para reducir el tráfico generado por la aplicación, 

mientras que los demás monitores permanecen encendidos. 

Un monitor individual puede ser deshabilitado desde la ventana Live Graphs, 

seleccionando el monitor deseado y ejecutando desde: Menú Principal 

Monitor>Disable this monitor; clic derecho en el monitor y seleccionar Disable this 

monitor o desde More Detail. De forma similar a la descrita anteriormente se 

puede volver a habilitar el monitor. 

Gráfico No. 1-21: Mensaje en pantalla de monitoreo 
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1.3.4.4. Eventos 

El registro de eventos puede ser usado para ver y tomar acciones en una 

condición anormal de la red antes que causen problemas; ofrece una herramienta 

de filtro muy potente que permite ver eventos de interés. La lista de eventos se 

presenta en la ventana principal. 

Gráfico No. 1-22: Ventana de eventos 

 

1.3.4.4.1. ¿Qué es un Evento? 

Un evento es una notificación registrada de algún suceso de interés que ha 

ocurrido en la red o dentro de la aplicación 3ComNS. Un evento puede suceder 

por las siguientes razones: 

 Un acontecimiento anormal en la red 

 Ha recibido un mensaje SNMP trap. 

 Finalización de una actividad interna dentro de 3ComNS. 

La lista de eventos pueden ser vistos desde la ventana Events List 

(Alerts/Events>View All Events) que provee un mecanismo para interpretar 

eventos en la red, permitiendo realizar algunas tareas: 
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 Filtrar y clasificar la lista de eventos, para permitir concentrar la atención en un 

evento particular de interés. 

 Obtener mayor información de eventos, que indican un acontecimiento 

anormal de la red e incluyen posibles causas y sugerencias para prevenir que 

suceda en el futuro. 

 Habilitar automáticamente la notificación de nuevos eventos, vía correo 

electrónico, buscapersonas y varias formas adicionales de notificación. 

1.3.4.4.2. Tipos de eventos 

Existen tres tipos básicos de eventos, que pueden ser generados dependiendo de 

la fuente que ha usado para generar el evento. 

 Eventos basado en monitoreo. Estos eventos son generados como 

resultado de una actividad de monitoreo de un dispositivo o conexión que 

entra en una condición anormal; describe la causa del problema y proporciona 

posibles soluciones. 

 Eventos basados en SNMP traps (mensajes SNMP). Mensajes SNMP traps 

recibidas por 3ComNS son procesadas y usadas para generar eventos, que 

son indicados claramente en la ventana Events con la descripción 

correspondiente. 

 Eventos internos de 3ComNS. Se generan estos eventos cuando 3ComNS 

realiza operaciones internas y proporciona una especie de auditoría para 

seguir el rastro de las tareas o configuraciones que se hayan realizado en el 

mapa de red. Por ejemplo, cuando se abre, cierra o crea un nuevo mapa se 

genera un evento. 
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1.3.4.4.3. Gravedad de los eventos  

Cada registro de eventos tiene un grado de severidad asociado, que indica el 

impacto del evento en la red. Existen 5 tipos de gravedad de eventos que en 

forma creciente son: información, advertencia, alto riesgo, crítico y recursivo. 

 Info (Información). La severidad de este evento es mínima, y no afecta 

negativamente a la red. Incluye acontecimientos como: abrir, cerrar, crear 

mapas, reinicio de servicios, etc. También es usado por eventos basados en 

SNMP traps. 

 Warning (Advertencia). Es usado por eventos que indican la presencia de un 

problema potencial en la red; permite tomar una acción preventiva para reducir 

la probabilidad de que ocurra un problema mayor. También es usado para 

mostrar eventos internos de 3ComNS que indican una falla de operación; por 

ejemplo, cuando no se ha podido realizar una actualización. 

 High (Alto riesgo). Este tipo de severidad es usado para indicar que ha 

ocurrido un problema grave en la red que puede resultar en una pérdida de 

conectividad de un limitado números de usuarios o puede afectar la fiabilidad 

de la red. 

 Critical (Crítico). De manera predeterminada, es usada para un tipo de 

evento en 3ComNS denominado Section of network down (sección de red 

caída) que es generado solamente cuando un  grupo de dispositivos en la red 

no responden, por lo tanto el monitoreo está detenido, y puede indicar un corte 

en la red.  

 Recurring (Recurrente).  Es usado cuando un mismo evento ocurre 

repetidamente, lo cual puede indicar un problema leve o potencial en la red. El 

evento es registrado una sola vez y actualiza detalladamente el número de 

veces que ha ocurrido.  Por ejemplo, un evento generado por el olvido de una 

contraseña y se intenta ingresar varias veces en forma incorrecta. 
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Cada nivel de severidad de los eventos tiene un color que identifica dentro de la 

lista de eventos para su fácil identificación. A continuación se muestra una tabla 

con sus respectivos colores: 

Tabla No. 5: Colores que representan la gravedad de eventos 

Color Severidad 

 Negro Recurring 

 Rojo oscuro Critical 

 Rojo High 

 Amarillo Warning 

 Turquesa Information 

1.3.4.4.4. Resolución de eventos 

Un registro de eventos que representan una condición anormal de la red, 

inicialmente es registrado como un Unsolved Event (evento no resuelto), que 

puede afectar el desempeño de la red.  

Cuando la conexión de un dispositivo no está disponible, no es posible resolver 

eventos basados en SNMP traps en forma manual; lo que obliga a restablecer la 

conexión antes de resolver un evento de éste tipo. Para otros tipos de eventos si 

es posible resolver manualmente realizando sugerencias que la aplicación 

presenta como posibles soluciones, para lo cual debe seleccionar el evento y 

luego dar clic en el menú principal de la ventana de eventos: Events>More Detail. 

De la misma forma, si un evento generado no interesa su resolución, se puede 

eliminar de la lista dando clic en el evento y seleccionando Edit>Delete. 

1.3.4.4.5. Deshabilitar y habilitar un evento.  

Si un evento en particular no es interesante, podemos prevenir para que este tipo 

de eventos no sean generados en el futuro, puede ejecutar desde 

Settings>Disable Events, y muestra una ventana donde permite habilitar y 

deshabilitar eventos. 
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Gráfico No. 1-23: Habilitar y deshabilitar eventos  

 

1.3.4.4.6. Administración de eventos 

Mientras corre el tiempo, los eventos se acumulan diariamente, por lo cual es 

necesario eliminar de la base de datos eventos antiguos que no son relevantes, 

para no tener acumulado mucha información que puede complicar la 

administración de la red. 

El proceso para controlar eventos antiguos denominado The Ageing Process  

tiene parámetros configurables: 

 Mantener eventos en forma permanente 

 Máximo números de días que se mantiene guardado los eventos. Si los 

eventos guardados tienen una antigüedad mayor al número de días 

configurado serán removidos de forma permanente de la aplicación. 

 Máximo número de eventos que se pueden guardar. Si el número de eventos 

guardados excede el número máximo permitido, los eventos marcados para 

eliminar son removidos, iniciando con los más antiguos, hasta igualar el 

número máximo de eventos permitidos.  

Lo eventos resueltos son removidos si exceden el número máximo permitido o si 

sobrepasan la antigüedad de los días configurado. Pero los eventos no resueltos 
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nunca son removidos por el Ageing Process, por lo que los eventos no resueltos 

deberán ser borrados manualmente, este hecho tiene como consecuencia que 

existan un número mayor de eventos no resueltos a los eventos permitidos, de 

igual forma pueden existir eventos no resueltos con mayor antigüedad a la 

permitida. 

Gráfico No. 1-24: Configuración de eventos antiguos 

 

Generalmente el proceso Agein Process se ejecuta una vez cada 24 horas a la 

media noche; lo que implica que temporalmente existirá mayor número de 

eventos a los configurados. 

1.3.4.5. Alertas 

Los eventos incorporan un sistema de alertas que permiten realizar una acción 

cuando se genere un evento. Las alertas pueden ser utilizadas para mantener 

actualizado el estado de la red cuando esté lejos del computador donde está 

corriendo 3ComNS, y realizar operaciones automáticamente cuando ocurre un 

evento, o simplemente informar de uno nuevo.  

En todas las redes, hay dispositivos y conexiones importantes que son clave para 

su operación de la red. Si estos dispositivos y conexiones fallan o funcionan 

incorrectamente, puede causar  problemas para los usuarios. Por esta razón, se  

pueden activar alertas para los dispositivos y enlaces, pero no para un evento. 
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Las alertas son  acciones (como un correo electrónico) que ocurren cuando un 

evento es generado para un dispositivo o el enlace, esto quiere decir que cuando 

uno de los monitores activos para el dispositivo o  conexión lee un estado 

anormal, el usuario es advertido de esta ocurrencia en forma inmediata. 

1.3.4.5.1. Tipos de alertas 

La aplicación ofrece varios tipos de alertas configurables cada uno con sus 

respectivos atributos, entre los más importantes: 

 Sound (Sonido). Proporciona una notificación por medio de un sonido de 

audio cuando se genera un evento en el computador donde está corriendo 

3ComNS. 

 Pop-up. Muestra automáticamente una ventana con detalles del evento que 

se ha generado. 

 Aplication. Ejecuta alguna aplicación o conjunto de archivos, pasando 

detalles de un evento que ha sido generado como parámetros de comandos 

de línea. 

 E-mail (Correo electrónico). Envía un e-mail con todos los detalles de un 

evento generado. 

 Pager (Buscapersonas). Envía un mensaje a un buscapersonas con los 

detalles del evento generado. 

 SNMP Trap. Envía un mensaje SNMP trap a un destino trap conteniendo 

detalles del evento generado. 

1.3.4.5.2. Configuración de alertas 

El cuadro de diálogo Configure Alerts permite ver alertas adjuntas a los ítems, 

crear nuevas alertas para los ítems y crear nuevos tipos de alertas. Que serán 

lanzadas de acuerdo a la configuración de la severidad de los eventos. 
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Para mostrar la ventana de alertas, existen algunas maneras:  

 Una vez seleccionado el evento, en el menú principal de la ventana de eventos 

seleccionar Events>Attach Alerts to Map Items; o dar clic derecho y 

seleccionar dicha opción. 

 Mediante el menú principal de 3ComNS seleccionar Alerts/Events > Configure 

Alerts for Selected Items o también seleccionando Alerts/Events > Configure 

Global Alerts 

El cuadro de diálogo Configure Alerts despliega un resumen de las alertas 

configuradas en el sistema, e indica que alertas están actualmente adjuntas a los 

ítems. 

Gráfico No. 1-25: Configuración de alertas 

 

Cuando se agrega o edita alertas es posible configurar varios detalles que 

describen en forma amplia el tipo de evento que ha generado; estos detalles se 

pueden configurar en los siguientes tipos de alertas como: Pop-up, e-mail, pager y 

SNMP Trap. 
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Tabla No. 7: Detalles soportados alertas 

Detalle Descripción 

$date$ Fecha cuando se generó el evento 

$time$ Hora cuando se generó el evento 

$device$ Nombre del ítem que ha generado el evento 

$ipAddr$ Direción IP del ítem que ha generado el evento 

$eventSeverity$ Severidad del evento generado 

$eventDescription$ Descripción del véneto generado 

$eventExplanation$ Una breve explicación del evento, incluyendo 
una posible causa y solución. 

NOTA: Configurando en la ventana Options en la pestaña Alerts, también es 

posible lanzar alertas para los eventos que han sido resueltos. 

1.3.5. REPORTES 

3ComNS también es capaz de generar informes detallados, describiendo las 

características de los dispositivos existentes en la red; pueden listar atributos 

como: direcciones IP, direcciones MAC, versiones de agentes de software, etc. 

Los reportes son generados en formato HTML que puede ser visto por un 

navegador web, pero también puede exportar a CSV, y archivos de Microsoft 

Excel.  

1.3.5.1. Tipos de reportes 

Dentro de 3ComNS puede generar varios tipos de reportes para transmitir 

información; los principales son: 

 Discovery. Se genera automáticamente cuando se ejecuta el proceso de 

descubrimiento de la red. 

 Misconfigurations and Optimizations. Este reporte describe cambios que 

pueden resolver problemas o mejorar el rendimiento de la red 
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 Priorization Configuration. Este reporte examina cada uno de los 

dispositivos 3Com en la red y sugiere una configuración para priorizar el 

desempeño de cada dispositivo. 

 Inventory. Enlista todos los dispositivos descubiertos por 3ComNS. Para cada 

dispositivo muestra los detalles: dirección IP, tipo de dispositivo, dirección 

MAC, nombre de dispositivo, etc. 

 Capacity. Este reporte permite calcular el número de puertos disponibles en la 

red, presentando los siguientes datos: dirección IP, tipo de dispositivo, total de 

puertos y puertos disponibles en el dispositivo. 

 Topology. Con este reporte se puede ver todas las conexiones entre 

dispositivos que están conectadas a la red. Muestra detalles para los 

dispositivos en cada conexión física: dirección IP, tipo de dispositivo, numero 

de unidad y número de puerto. 

1.3.5.2. Cuadro de diálogo Reports 

El cuadro de diálogo Reports despliega una lista de todos los tipos de reportes 

que pueden ser generados, incluyendo aquellas que el usuario haya agregado. 

Gráfico No. 1-26: Cuadro de diálogo reportes 
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En la parte inferior de la pestaña Generate Report sespliega información referente 

al tipo de reporte seleccionado; nombre, descripción, contenido, columnas, etc. 

La pestaña History muestra un historial de los reportes realizados, indicando el 

tipo de reporte y la fecha cuando fue generado. Además presenta un botón para 

importar el reporte a formato CSV que puede ser leído con Microsoft Excel, y 

permite eliminar cualquier reporte seleccionado. 

1.3.5.3. Agregar y editar reportes 

Para agregar o editar reportes personalizados, dar clic en Custom Reports Types 

del cuadro de diálogo Reports y seleccionar Add o Edit para ejecutar el asistente 

de creación de reportes. Una vez iniciado el asistente presenta el primer y más 

importante cuadro de diálogo: 

Gráfico No. 1-27: Asistente para agregar reportes 

 

En el contenido (Content) puede seleccionar Node Details o Link Details que hace 

referencia a los detalles que están disponibles de los nodos y conexiones 

respectivamente, para generar el reporte deseado. 
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Tabla No. 08: Detalles disponibles en reportes para nodos 

Columna  Descripción 

Commenmt Comentario asociado con el dispositivo 

Device Name Nombre del dispositivo 

Device Type Tipo de dispositivo 

Extension Number Extensión de dispositivos telefónicos 

Hardware Version Versión del hardware, especialmente para dispositivos 
3Com. 

IP Address Dirección IP del dispositivo 

Location Localización del dispositivo, solo aplica para dispositivos 
telefónicos.  

MAC Address Dirección MAC asociado con el dispositivo 

Number of Units Número de unidades (tarjetas) que tiene un dispositivo 

Columna  Descripción (continuación) 

Ports Available Número de puertos disponibles en el dispositivo 

Product Number Número de producto del dispositivo, sólo de dispositivos 
3Com. 

Registered Si el dispositivo ha sido registrado con 3Com utilizando la 
garantía. 

Serial Number Número de serie del dispositivo, sólo de dispositivos 
3Com 

Software Version Versión del software utilizado por dispositivos 3Com.  

Subnet La subred a donde pertenece el dispositivo. 

Objetos SNMP Valores referentes a objetos SNMP para el dispositivo 
(sysContact, sysDescr, sysLocation, sysName, etc.) 

Total Ports El número total de puertos en el dispositivo 

Used Ports El número de puertos usados en el dispositivo 

User Departament 
/Name /Title 

El departamento, nombre y título del usuario del 
dispositivo; sólo aplica para dispositivos telefónicos 
compatibles. 

 

Tabla No. 09: Detalles disponibles en reportes para conexiones 

Columna  Descripción 

Comment Comentarios asociados con el dispositivo en las dos 
terminales de la conexión. 

Device Name Nombre de los dispositivos en las dos terminales de la 
conexión. 

Duplex Mode El modo Duplex de la conexión 

IP Address Direcciones IPs de los dispositivos en las dos terminales 
de la conexión. 

Link Aggregation Muestra si está habilitado o deshabilitado Link 
Aggregation 
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Media Type El tipo de medio utilizado para la conexión. Por ejemplo: 
Ethernet 

Port Obtiene el número de puertos asociados a las dos 
terminales de la conexión. 

Registered Si los dispositivos han sido registrados con 3Com 
utilizando la garantía y están asociados a las dos 
terminales de la conexión. 

Resilience Mode Si el modo Resilience está habilitado para esta conexión 

Spanning Tree 
Mode 

Muestra el modo Spanning Tree de la conexión. 

Speed Muestra la velocidad de la conexión 

1.4. REFERENCIAS 

1.4.1. 3COM 

3Com NASDAQ: COMS es uno de los líderes en fabricación de equipos para 

infraestructura de Redes Informáticas. La compañía fue fundada por Robert 

Metcalfe y otros socios en 1979 y su sede social está en Marlborough, 

Massachusetts. El nombre 3Com hace referencia a que los intereses de la 

compañía son Computadoras, Comunicaciones y Compatibilidad. 

1.4.2. ARP BROADCAST 

Las redes ethernet emplean el broadcast para conocer qué dirección ethernet 

física (MAC) tiene el sistema con una IP determinada, que es lo que necesita un 

adaptador ethernet para comunicarse con otro (las IP     curiosamente no trabajan 

a este nivel tan bajo). Si la máscara está mal en algún sistema este será 

inaccesible para los demás y tampoco podrá acceder a los demás. 

1.4.3. DIRECCIÓN IP. 

Una dirección IP es un número que identifica de manera lógica y jerárquica a una 

interfaz de un dispositivo (habitualmente una computadora) dentro de una red que 

utilice el protocolo IP (Internet Protocol), que corresponde al nivel de red del 

protocolo TCP/IP. Dicho número no se ha de confundir con la dirección MAC que 

es un número hexadecimal fijo que es asignado a la tarjeta o dispositivo de red 

por el fabricante, mientras que la dirección IP se puede cambiar. 
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1.4.4. DIRECCIÓN MAC 

En redes de computadoras la dirección MAC (siglas en inglés de Media Access 

Control o control de acceso al medio) es un identificador de 48 bits (6 octetos) que 

corresponde de forma única a una ethernet de red. Es individual, cada dispositivo 

tiene su propia dirección MAC determinada y configurada por el IEEE (los últimos 

24 bits) y el fabricante (los primeros 24 bits) utilizando el OUI. La mayoría de los 

protocolos que trabajan en la capa 2 del modelo OSI usan una de las tres 

numeraciones manejadas por el IEEE: MAC-48, EUI-48, y EUI-64 las cuales han 

sido diseñadas para ser identificadores globalmente únicos. No todos los 

protocolos de comunicación usan direcciones MAC, y no todos los protocolos 

requieren identificadores globalmente únicos. 

Las direcciones MAC son únicas a nivel mundial, puesto que son escritas 

directamente, en forma binaria, en el hardware en su momento de fabricación. 

Debido a esto, las direcciones MAC son a veces llamadas "Direcciones 

Quemadas Dentro" (BIA, por las siglas de Burned-in Address). 

1.4.5. DNS 

Es una base de datos distribuida, con información que se usa para traducir los 

nombres de dominio, fáciles de recordar y usar por las personas, en números de 

protocolo de Internet (IP) que es la forma en la que las máquinas pueden 

encontrarse en Internet. 

Un servidor DNS permite conectarse con la máquina sin necesidad de usar su 

dirección IP; basta con ingresar el dominio para que el servidor DNS resuelva y 

establezca una conexión. 

1.4.6. DISPOSITIVOS VCX 

Los dispositivos 3Com® VCX™ Gateways permiten la interconexión de redes 

entre la red IP y los equipos y las aplicaciones legacy, incluyendo PBXs y la red 

pública de switching telefónico (PSTN). Las empresas despliegan las gateways 

junto con el 3Com IP Telephony Module, que forma parte de la suite de 

http://es.wikipedia.org/wiki/Redes_de_computadoras
http://es.wikipedia.org/wiki/Control_de_acceso_al_medio
http://es.wikipedia.org/wiki/IEEE
http://es.wikipedia.org/wiki/OUI
http://es.wikipedia.org/wiki/Nivel_de_enlace_de_datos
http://es.wikipedia.org/wiki/IEEE
http://es.wikipedia.org/wiki/Hardware
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aplicaciones de convergencia de 3Com, para mediar en la señalización de control, 

administrar las llamadas y facilitar el acceso a servicios de la red de trunking IP. 

1.4.7. HTTP 

El protocolo de transferencia de hipertexto (HTTP, HyperText Transfer Protocol) 

es el protocolo usado en cada transacción de la Web (WWW). HTTP fue 

desarrollado por el consorcio W3C y la IETF, colaboración que culminó en 1999 

con la publicación de una serie de RFC, siendo el más importante de ellos el RFC 

2616, que especifica la versión 1.1. HTTP define la sintaxis y la semántica que 

utilizan los elementos software de la arquitectura web (clientes, servidores, 

proxies) para comunicarse. 

1.4.8. PING 

Es una forma abreviada de Packet Internet Groper. Es una de las herramientas 

más simples en la administración de redes ya que todo lo que hace es enviar 

paquetes para verificar si una máquina remota está respondiendo y, por ende, si 

es accesible a través de la red. 

1.4.9. PROTOCOLO 

El Protocolo de red o también Protocolo de Comunicación es el conjunto de reglas 

que especifican el intercambio de datos u órdenes durante la comunicación entre 

las entidades que forman parte de una red. Estándares de redes: 

IEEE 802.3, estándar para Ethernet  

IEEE 802.5, estándar para Token Ring  

IEEE 802.11, estándar para Wi-Fi  

IEEE 802.15, estándar para Bluetooth 

1.4.10. PROTOCOLO SNMP 

El Protocolo Simple de Administración de Red o (SNMP por sus siglas en inglés) 

es un protocolo de la capa de aplicación del modelo OSI que facilita el intercambio 

de información de administración entre dispositivos de red. Es parte de la familia 
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de protocolos TCP/IP. SNMP permite a los administradores supervisar el 

desempeño de la red, buscar y resolver sus problemas, y planear su crecimiento. 

1.4.11. PROTOCOLO ICMP.  

El Protocolo de Mensajes de Control de Internet o ICMP (por sus siglas de 

Internet Control Message Protocol) es el sub protocolo de control y notificación de 

errores del Protocolo de Internet (IP). Como tal, se usa para enviar mensajes de 

error, indicando por ejemplo que un servicio determinado no está disponible o que 

un router o host no puede ser localizado. 

1.4.12. PROTOCOLO IEEE 802.1Q 

El protocolo IEEE 802.1Q interconecta VLAN entre varios swtches, routers y 

servidores, utilizando un mecanismo de etiquetado de tramas que añade un 

identificador de VLAN a la trama mediante la inserción de una etiqueta en la capa 

2. Con este protocolo un administrador de redes puede definir una topología 

VLAN para extender varios dispositivos físicos 

1.4.13. SNMP-MIB 

El Protocolo Simple de Administración de Red o SNMP es un protocolo de la capa 

de aplicación que facilita el intercambio de información de administración entre 

dispositivos de red. Es parte de la familia de protocolos TCP/IP. SNMP permite a 

los administradores supervisar el desempeño de la red, buscar y resolver sus 

problemas, y planear su crecimiento. 

Una Base de Información de Administración (MIB) es una colección de 

información que está organizada jerárquicamente. Las MIB‟s son accedidas 

usando un protocolo de administración de red, como por ejemplo, SNMP. 

Un objeto administrado (algunas veces llamado objeto MIB, objeto, o MIB) es uno 

de cualquier número de características específicas de un dispositivo administrado. 

Los objetos administrados están compuestos de una o más instancias de objeto, 

que son esencialmente variables. 
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1.4.14. SWITCH 

Un conmutador o switch es un dispositivo digital de lógica de interconexión de 

redes de computadores que opera en la capa 2 (nivel de enlace de datos) del 

modelo OSI. Su función es interconectar dos o más segmentos de red, de manera 

similar a los puentes (bridges), pasando datos de un segmento a otro de acuerdo 

con la dirección MAC de destino de las tramas en la red. 

Los conmutadores se utilizan cuando se desea conectar múltiples redes, 

fusionándolas en una sola. Al igual que los puentes, dado que funcionan como un 

filtro en la red, mejoran el rendimiento y la seguridad de las LANs (Local Area 

Network- Red de Área Local). 

1.4.15. RED 

Una red de computadoras (también llamada red de ordenadores o red informática) 

es un conjunto de equipos (computadoras y/o dispositivos) conectados por medio 

de cables, señales, ondas o cualquier otro método de transporte de datos, que 

comparten información (archivos), recursos (CD-ROM, impresoras, etc.) y 

servicios (acceso a internet, e-mail, chat, juegos), etc. 

1.4.16. ROUTER 

El enrutador (del inglés router), direccionador, ruteador o encaminador es un 

dispositivo de hardware para interconexión de red de ordenadores que opera en 

la capa tres del modelo OSI (nivel de red). Un router es un dispositivo para la 

interconexión de redes informáticas que permite asegurar el enrutamiento de 

paquetes entre redes o determinar la ruta que debe tomar el paquete de datos. 

Cuando un usuario accede a una URL, el cliente web (navegador) consulta al 

servidor de nombre de dominio, el cual le indica la dirección IP del equipo 

deseado. 

1.4.17. TCP/IP 

La familia de protocolos de Internet es un conjunto de protocolos de red en la que 

se basa Internet y que permiten la transmisión de datos entre redes de 

computadoras. En ocasiones se le denomina conjunto de protocolos TCP/IP, en 



   

59 

 

referencia a los dos protocolos más importantes que la componen: Protocolo de 

Control de Transmisión (TCP) y Protocolo de Internet (IP), que fueron los dos 

primeros en definirse, y que son los más utilizados de la familia. Existen tantos 

protocolos en este conjunto que llegan a ser más de 100 diferentes, entre ellos se 

encuentra el popular HTTP, que es el que se utiliza para acceder a las páginas 

web, además de otros como el ARP (Address Resolution Protocol) para la 

resolución de direcciones, el FTP (File Transfer Protocol) para transferencia de 

archivos, y el SMTP (Simple Mail Transfer Protocol) y el POP (Post Office 

Protocol) para correo electrónico, TELNET para acceder a equipos remotos, entre 

otros. 

1.4.18. UDP 

Viene de las siglas de User Datagram Protocol, que es un protocolo del nivel de 

transporte basado en el intercambio de datagramas. Permite el envío de 

datagramas a través de la red sin que se haya establecido previamente una 

conexión, ya que el propio datagrama incorpora suficiente información de 

direccionamiento en su cabecera 

1.4.19. VLAN 

Una VLAN (acrónimo de Virtual LAN, „red de área local virtual‟) es un método de 

crear redes lógicamente independientes dentro de una misma red física. Varias 

VLANs pueden coexistir en un único conmutador físico o en una única red física. 

Son útiles para reducir el tamaño del Dominio de difusión y ayudan en la 

administración de la red separando segmentos lógicos de una red de área local 

(como departamentos de una empresa) que no deberían intercambiar datos 

usando la red local (aunque podrían hacerlo a través de un enrutador o un switch 

capa 3). 

1.4.20. VOIP 

Voz sobre Protocolo de Internet, también llamado Voz sobre IP, VozIP, VoIP (por 

sus siglas en inglés), es un grupo de recursos que hacen posible que la señal de 

voz viaje a través de Internet empleando un protocolo IP (Internet Protocol). Esto 

significa que se envía la señal de voz en forma digital en paquetes en lugar de 
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enviarla (en forma digital o analógica) a través de circuitos utilizables sólo para 

telefonía como una compañía telefónica convencional o PSTN (sigla de Public 

switched Telephone Network, Red Telefónica Pública Conmutada). 

1.4.21. WINDOWS API 

La Interfaz de Programación de Aplicaciones, cuyo acrónimo en inglés es API 

(Application Programming Interface), es un conjunto de funciones residentes en 

bibliotecas (generalmente dinámicas, también llamadas DLLs por sus siglas en 

inglés, término usado para referirse a éstas en Windows) que permiten que una 

aplicación corra bajo un determinado sistema operativo. En este caso se refiere a 

las aplicaciones Windows. 
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1.5. PREGUNTAS MÁS FRECUENTES 

1.5.1. ¿QUÉ ES LIVE UPDATE? 

Live Update es un servicio que ofrece tanto 3Com Network Supervisor como 

3Com Network Director, que mantiene actualizado el software corrigiendo bugs e 

instalando Servipacks. Para ejecutar Live Update debe estar configurada 

correctamente la conexión a internet, y seleccionar desde el menú principal 

Tools>Live Update. 

1.5.2. ¿QUÉ OCURRE CUANDO UN MAPA DE RED ES REDESCUBIERTO? 

Cuando un mapa está abierto y empieza el proceso de descubrimiento de la red, 

3ComNS combina los nuevos dispositivos y se vincula en el mapa de la red 

existente. 

Si hay diferencias de dispositivo o conflictos (como ejemplo, dirección IP 

duplicada), 3ComNS  realiza lo siguiente: 

 Si un nuevo dispositivo tiene la misma dirección IP de un dispositivo existente 

(pero tiene  una dirección  Mac diferente), el dispositivo existente y sus 

conexiones son reemplazados por  el  nuevo  dispositivo o conexión. 

 Si un dispositivo existente no es encontrado en el proceso de 

redescubrimiento, 3ComNS podría haber descubierto una parte diferente de la 

red, o que el dispositivo actual no esté respondiendo, para lo cual se deberá 

verificar el estado (color) del dispositivo en el mapa de red. 

 Los nuevos dispositivos son añadidos al mapa. 

1.5.3. ¿QUÉ REPRESENTA LA NUBE SOBRE EL MAPA DE LA RED? 

El 3ComNS  usa nubes sobre el mapa de la red para identificar partes de la red 

que no ha sido identificada durante el descubrimiento o para identificar acceso a 

Internet. La presencia de nubes puede darse porque los dispositivos tienen 
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problemas y no pueden ser reconocidos, o se ha perdido la conexión o no se 

puede recabar la información correspondiente para determinar la topología de la 

red. 

1.5.4. ¿CÓMO PUEDO UBICAR UN DISPOSITIVO? 

Para ubicarlos rápidamente  un dispositivo en la red se puede utilizar el cuadro de 

diálogo de búsqueda, seleccionando del menú principal Edit>Find. 

Gráfico No. 1-28: Cuadro de diálogo de búsqueda 

 

En el cuadro de diálogo, seleccionar el tipo de búsqueda por dispositivos, 

conexiones, componentes telefónicos, etc.; luego seleccionar el criterio sea por 

nombre, dirección MAC, dirección IP, etc. Finalmente, ingresar el nombre de la 

búsqueda en el cuadro name. 

1.5.5. ¿CÓMO INICIAR EL MONITOREO DE UNO O VARIOS DISPOSITIVO O 

CONEXIONES? 

Para iniciar el monitoreo de un dispositivo o conexión descubierto en la red, 

simplemente seleccionar uno o varios ítem, dar clic derecho y ejecutar Start 

Monitoring o desde el menú principal Monitoring>Start monitoring. Para 

seleccionar varios dispositivos puede dibujar un rectángulo en el mapa, 

manteniendo clic derecho sostenido, o también seleccionar varios dispositivos 

mientras mantiene presionado la tecla control. 
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1.5.6. ¿CÓMO INFORMA 3ComNS CUANDO EXISTE UN PROBLEMA EN LA 

RED? 

Se  puede monitorear la condición de tensión de dispositivos y los enlaces en la 

red, buscando niveles de tensión altos (las condiciones anormales). Usted puede 

dar los alertas a estos dispositivos y enlaces, usted es informado cuando los 

niveles de tensión altos son detectados, demostrando los problemas potenciales. 

1.5.7. ¿CÓMO SE PUEDE SABER QUÉ PUERTOS ESTÁN DISPONIBLES PARA 

EL USO? 

Mediante la creación de un reporte de capacidad (Capacity) se puede conocer el 

número de puertos disponibles que restan en la red. Para crear un reporte 

ingresar en el menú principal y seleccionar Tools>Reports>Capacity>Generate 

Report 
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CAPÍTULO II 

PAQUETE AVANZADO 

2.1. GENERALIDADES 

El tema planteado en el Plan de Trabajo de Grado se refiere al software 3Com 

Network Supervisor, que el temario del Capítulo 2 referente al Paquete Avanzado 

fue tomado como referencia la versión del software 4.1 del año 2003, pero al 

momento de instalar el Paquete Avanzado la empresa 3Com ya no permite bajar 

esta actualización; en su remplazo las funcionalidades del 3ComNS versión 4.1 

con su paquete avanzado han sido separados en dos tipos de software diferentes: 

 3Com Network Supervisor 6.0. Este software tiene las funciones básicas de 

monitoreo de redes, pero ya no dispone del paquete avanzado que en 

versiones anteriores permitía instalar por separado. El capítulo uno del 

presente trabajo describe las funciones de éste software. 

 3Com Network Director 3.0. 3ComND tiene todas las funcionalidades del 

3Com Network Supervisor 6.0 incluida las funciones avanzadas que disponía 

en versiones anteriores como una actualización con el paquete avanzado y 

otras que están disponibles solo en éste software. 

Por las razones descritas anteriormente, y para que el presente trabajo de grado 

no sea rechazado, en éste capítulo principalmente se describirá las funciones 

principales que existían en el paquete avanzado de versiones anteriores y que 

actualmente están presentes en 3Com Network Director. 



   

65 

 

2.2. INTRODUCCIÓN  

El paquete avanzado del 3Com Network Supervisor en versiones anteriores y 

actualmente incluidas en 3Com Network Director, mejora las prestaciones del 

monitoreo de redes elevando la funcionalidad del software, logrando ampliar las 

expectativas del administrador de redes; para lo cual agrega algunas funciones 

avanzadas: 

 Incrementa el tamaño de redes que pueden ser manejados por 3com Network 

Director hasta 5000 nodos. 

 Es posible realizar copias de seguridad y restaurar la configuración de uno o 

más dispositivos de la red. 

 Permite aplicar la configuración del software de un dispositivo o un respaldo a 

uno o varios dispositivos del mismo tipo y configuración física. 

 Mediante la programación de un calendario, permite preparar varias 

operaciones que pueden iniciar en un momento determinado, sin tener que 

operar la computadora que la administra.   

 Se pueden obtener reportes comprensivos del estado de actualización, 

respaldo e historia de un dispositivo, así como obtener un historial completo de 

la actualización, copias de seguridad y respaldos.   

 Permite ver, crear y editar redes VLANs. Es decir, encuentra todos los 

dispositivos en una VLAN determinada, detalla la información de los 

dispositivos específicos y conexiones.   

 La función Agent Update puede actualizar los dispositivos con la última versión 

disponible en el puesto de trabajo local, o cualquier otra versión disponible. 

También se puede descargar la última versión del agente de software para 

todos los dispositivos soportados, desde la página web de 3Com hasta la 

estación de trabajo de 3Com Network Director. 
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 Permite seleccionar el nivel de monitoreo a ser usado en los dispositivos en la 

red. El nivel de monitoreo (especialmente en una red con un gran número de 

dispositivos) puede afectar el desempeño del computador donde está 

ejecutándose 3ComND.   

2.3. CARACTERÍSTICAS 

Se describen las principales características del paquete a avanzado (funciones 

avanzadas) disponibles en 3ComND. 

3.1.1. RED DE ÁREA LOCAL VIRTUAL (VLAN) 

Una VLAN es un método de crear redes lógicamente independientes dentro de 

una misma red física. Varias VLANs pueden coexistir en un único conmutador 

físico o en una única red física (un mismo switch). Son útiles para reducir el 

tamaño del dominio de difusión y ayudan en la administración de la red separando 

segmentos lógicos de una red de área local (como departamentos de una 

empresa) que no deberían intercambiar datos usando la red local. 

Dicho de otro modo, una VLAN consiste en una red de ordenadores que se 

comportan como si estuviesen conectados al mismo conmutador, aunque pueden 

estar en realidad conectados físicamente a diferentes segmentos de una red de 

área local. Los administradores de red configuran las VLANs mediante software 

en lugar de hardware, lo que las hace extremadamente flexibles. Una de las 

mayores ventajas de las VLANs surge cuando se traslada físicamente algún 

ordenador a otra ubicación: puede permanecer en la misma VLAN sin necesidad 

de cambiar la configuración IP de la máquina. 
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Gráfico No. 2-1: Representación gráfica de una VLAN  

 

3.1.1.1. Protocolos VLAN 

El protocolo IEEE 802.1Q es utilizado para la configuración de las VLANs. Antes 

de su introducción existían varios protocolos propietarios, como el ISL (Inter-

switch Link) de Cisco, una variante del IEEE 802.1Q, y el VLT (Virtual LAN Trunk) 

de 3Com. 

Las VLANs funcionan en la capa 2 (enlace de datos) del modelo OSI. Sin 

embargo, los administradores suelen configurar las VLANs como correspondencia 

directa de una red o subred IP, lo que les da apariencia de funcionar en el nivel 3 

(red). En el contexto de las VLANs, el término trunk („troncal‟) designa una 

conexión de red que transporta múltiples VLANs identificadas por etiquetas (o 

tags) insertadas en sus paquetes. Dichos trunks deben operar entre tagged ports 

(puertos etiquetados) de dispositivos con soporte de VLANs, por lo que a menudo 

son enlaces conmutador a conmutador o conmutador a enrutador más que 

enlaces a nodos. Un enrutador (conmutador de nivel 3) funciona como columna 

vertebral para el tráfico de red transmitido entre diferentes VLANs. 
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Configurar VLANs en los switches disminuye el tiempo y esfuerzo requerido para 

muchas tareas de administración de redes e incrementa la eficiencia de la red, lo 

que proporciona segmentación y flexibilidad de organización; agrupando puertos 

de switch y sus usuarios conectados lógicamente en una misma red, aunque 

estén físicamente separados. Es decir con una VLAN no es necesaria la 

existencia de un router para definir el dominio de difusión. 

3.1.1.2. VLANs en 3com Network Director 

3Com Network Director puede realizar varias tareas con VLANs, entre ellas: crear 

VLANs, descubrir la topología de la VLAN, ver el mapa expandido de la VLAN, 

encontrar todos los dispositivos en una determinada VLAN, ver información 

detallada de VLANs referente a dispositivos específicos y sus conexiones, 

generar reportes que contienen información de la configuración de las redes 

VLANs. 

En el descubrimiento de red, la aplicación recupera información de VLANs 

referente a: 

 Descripción textual de la VLAN 

 802.1Q VLAN ID 

 Puertos en el dispositivo que son etiquetados los miembros de la VLAN 

 Puertos en el dispositivo que no son etiquetados los miembros de la VLAN 

 Alguna información de capa 3 asociados con la VLAN, por ejemplo: dirección 

IP, mascara de subred, etc. 

 Número de dispositivos que no tienen configurado VLANs. 

NOTA: No todos los dispositivos están soportados para las VLANs. 3ComND 

restringe el soporte de VLANs a los siguientes dispositivos. 



   

69 

 

 switches que no son 3Com. Es decir, VLANs que ha sido creados en 

dispositivos que no son 3Com no se puede mostrar, crear ni modificar. 

 switches 3Com antiguos como switch 1000 y 3000 las VLANs son basados en 

un mecanismo llamado VLT (Virtual LAN Trunking), que no es soportado en 

3ComND. 

3.1.1.3. Mostrar VLANs 

Para mostrar redes VLANs en 3ComND seleccionar Tools>Show VLANs del 

menú principal de la aplicación, donde muestra la barra de herramientas de 

VLANs. 

Gráfico No. 2-2: Barra de herramientas VLAN 

 

Al seleccionar una de las VLANs desde la lista resultante, resalta los ítems 

pertenecientes a la red virtual, mientras que los dispositivos y conexiones que no 

pertenecen a la red virtual son mostrados de color gris. Por ejemplo, la figura No. 

2-3 indica que solamente el switch, dos conexiones y una PC son parte de una 

red virtual.  
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Gráfico No. 2-3: VLAN en el mapa de red 

 

Cuando seleccionamos una VLAN de la barra de tareas Show VLANs, el mapa es 

ajustado y movido automáticamente para mostrar todos los miembros de la red 

virtual seleccionada. 

3.1.1.4. Mapas que no contienen redes virtuales 

Si el mapa actual no contiene información de VLANs, cuando se ejecuta Show 

VLANs se despliega un cuadro de mensaje que indica que el mapa actual no 

contiene información de VLAN; este fenómeno se puede dar por varias razones: 

 El mapa fue creado originalmente usando versiones anteriores al 3.5 de 3Com 

Network Supervisor. 

 Realmente no existen VLANs configuradas en la red. 

 Las VLANs configuradas en la red están utilizando dispositivos que no son 

3Com. 



   

71 

 

Si los todos los switches solamente tienen configurado una VLAN 

predeterminada, se despliega un mensaje de aviso que indica que no existe 

VLANs configuradas, solamente la VLANs predeterminada. 

3.1.1.5. Propiedades de switches que contienen VLANs 

Solo en la pestaña del cuadro de diálogo Properties de un switch que contiene 

VLANs, muestra la siguiente información: 

 Una lista de todas las VLANs configuradas en el switch. 

 Los puertos configurados en la actual VLAN seleccionada. 

 Detalles del protocolo, configurados en dispositivos de capa 3. 

Gráfico No. 2-4: Propiedades de switches que contienen VLANs 
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3.1.1.6. Crear, editar y eliminar una VLAN 

La configuración de VLANs demanda de conocimientos avanzados en 

configuración de redes, VLANs, dispositivos de Capa 3 del modelo OSI, 

conexiones y varios conceptos adicionales; por tal razón, en los párrafos 

siguientes se explica brevemente esta configuración, sin alguna parte del texto no 

se entiende debe investigar o consultar la ayuda de la aplicación. 

Para crear una nueva VLAN, la aplicación ejecuta un asistente que guía a través 

de proceso de creación de la nueva VLAN. Para ejecutar el asistente se debe 

seleccionar Device>VLAN>Create a VLAN; y para editar una VLAN, debe 

seleccionar Device>VLAN>Edit Port VLAN Membership. El asistente de creación 

y edición de VLANs es similar; y solicita la siguiente configuración. 

 Ingresar nombre y la identificación ID. El nombre que identifica a la red 

virtual puede tener hasta 32 caracteres. VLAN ID, es la identificación de VLAN 

y puede tener valores entre 2-4094; sin embargo si selecciona una VLAN ID 

que ya está en uso en la red, la aplicación dará una advertencia, pero no 

evitará que se cree la VLAN. VLAN ID = 1 es reservado para la VLAN 

predeterminada. 

Gráfico No. 2-5: Asistente para crear VLANs 
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 Editar y seleccionar switches y puertos. En este paso la aplicación muestra 

la lista de switches y puertos que podrán ser utilizados para crear la VLAN. 

Para crear una VLAN se debe tener conocimiento avanzado en configuración 

de redes y de switches de capa 3, caso contrario la VLAN construida podría 

mostrar un resultado inesperado, o simplemente se lograría crear. 

Gráfico No. 2-6: Editar y seleccionar switches para una nueva VLAN 

  

 Configuración de puertos adicionales. La misma aplicación determina si 

existen puertos adicionales que podrían ser configurados para completar la 

creación de la nueva VLAN. De igual forma, se debe tener vasto conocimiento 

en área de redes para continuar la configuración. Luego de este paso, 

3ComND chequea la VLAN creada para que no exceda los límites permitidos 

por los switches. 
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Gráfico No. 2-7: Agregar puertos adicionales en una nueva VLAN 

 

 Configuración de VLANs en dispositivos no 3Com. La aplicación no 

soporta la configuración de VLANs en dispositivos diferentes a la marca 3Com; 

para realizar ésta configuración se debe realizar manualmente utilizando 

Interface Telnet para switches o cualquier otra aplicación. 

Gráfico No. 2-8: Configuración manual de una VLAN 
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 Agregar una interface de IP routing. Este paso permite especificar un nuevo 

interface de IP routing a ser utilizado en la VLAN. 

 Guardar la configuración. Una vez configurado la IP de interface para la 

nueva VLAN, muestra el cuadro de diálogo Save Device Configuration; donde 

se decide sí la configuración será permanente, lo que significa que la 

configuración será guardada en el dispositivo como una configuración 

predeterminada inclusive si el switch es reiniciado. 

Gráfico No. 2-9: Guardar configuración predeterminada de una VLAN 

 

 Finalmente, el asistente muestra el resumen de la configuración de la VLAN y 

termina el proceso. 

3.1.1.7. Eliminar una VLAN 

 Eliminar una VLAN es una operación arriesgada y puede traer serias 

repercusiones, incluyendo pérdida de conectividad de alguno o todos los 

dispositivos de la red. El asistente de eliminación guiará hasta el final del proceso, 

durante todas las etapas debe ser muy cuidadoso para seleccionar las 

configuraciones correctas. Para mayor información consultar la ayuda de la 

aplicación. 
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3.1.2. CONFIGURACIÓN DE DISPOSITIVOS (BULK CONFIGURATION) 

La configuración centralizada de dispositivos se refiere a que 3ComND puede ser 

usado para establecer un rango de configuraciones de uno o varios dispositivos 

3Com en la red con una sencilla operación. Esta herramienta puede ayudar  a 

realizar cambios comunes al software de configuración de múltiplos dispositivos 

en una misma operación. Las configuraciones que se desea administrar pueden 

ser definidas en la creación de una plantilla de configuraciones a ser aplicadas a 

los dispositivos durante la operación de configuración. 

Bulk Configuration puede ser utilizado para las siguientes actividades. 

 Crear, editar y guardar plantillas de configuraciones para controlar el 

comportamiento de los dispositivos en la red. 

 Seleccionar un grupo de dispositivos o puertos para aplicar una configuración. 

 Realizar un cambio de configuración para uno o varios dispositivos soportados 

del mismo o diferente tipo en una misma operación. 

3.1.2.1. Plantillas 

Las plantillas de configuración permiten al usuario definir una configuración 

específica que puede ser aplicado a una selección de dispositivos o puertos. Las 

plantillas proporcionan una variedad de atributos agrupados por características 

que permiten especificar de acuerdo a las necesidades. 

Todos los atributos que contiene una plantilla, inicialmente están deshabilitadas 

por defecto, y es posible escoger que atributos configurar, o de una sola vez 

habilitar todos ellos, de acuerdo a las necesidades. Existen dos tipos de plantillas: 

 Para dispositivos switch. Proporciona acceso a todos los atributos que 

3ComND puede configurar en switches soportados. 
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 Para los puertos del switch. Proporciona acceso a todos los atributos que 

3ComND puede configurar en los puertos de los switches soportados. 

3.1.2.2. Configuración de plantillas 

Para crear, editar y guardar configuraciones en una plantilla es necesario ejecutar 

el cuadro de diálogo Configuration Editor que contiene los atributos a aplicarse a 

los dispositivos o puertos seleccionados. Para ejecutar el cuadro de diálogo 

seleccionar la opción switch Devices, switch Ports o Access Points desde el menú 

principal Device>Configure. 

Gráfico No. 2-10: Configuración de plantillas 

 

El gráfico No. 2-10 representa el contenido de la configuración de una plantilla 

usando un número de características basadas en paneles. Cada panel contiene 

atributos configurables, donde se puede realizar todas las configuraciones 

soportadas por los dispositivos. 

3.1.2.3. Selección de dispositivos 

Mediante el cuadro de diálogo Selecction Editor se puede escoger y modificar la 

selección de los dispositivos y puertos a aplicarse la plantilla de configuración. Se 
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puede acceder desde el cuadro de diálogo Configuration Editor dando clic en el 

botón Edit Selecction. 

Gráfico No. 2-11: Configuración de plantillas 

 

3.1.2.4. Aplicar configuración 

Una vez que está lista la plantilla de configuración, al seleccionar el botón OK en 

el cuadro de diálogo Configure Editor, 3ComND valida cada uno de los atributos 

configurados y asegura que la actual selección sea soportada para cada 

dispositivo o puerto antes de continuar, de no ser así presenta un mensaje 

preguntando si desea continuar; inmediatamente después despliega el cuadro de 

diálogo Configuration Progress que muestra el estado de la configuración de los 

dispositivos. 

Gráfico No. 2-12: Cuadro de diálogo Configuration Progress 

 



   

79 

 

3.1.3. RESPALDO Y RESTAURACIÓN 

La función copia de seguridad (Device Backup) guarda una copia de seguridad de 

la configuración de uno o más recursos de la red, almacenando cada 

configuración en archivos separados (backup file). 

Device Backup puede ayudar eficientemente a la administración de la 

configuración de recursos; por ejemplo, después de personalizar la configuración 

de un dispositivo se puede realizar la copia de seguridad para guardar la 

configuración en un archivo de respaldo por propósitos de seguridad. Esto permite 

realizar una restauración rápida cuando se haya realizado una incorrecta o fallida 

configuración de un dispositivo. Además la configuración guardada se puede 

aplicar a múltiples dispositivos de un mismo tipo, usando la función Bulk 

Configuration en lugar de realizar la configuración de cada dispositivo 

individualmente. 

Efectivamente, con 3ComND podemos realizar copias de seguridad de la 

configuración de dispositivos y luego utilizarlas para restaurar una configuración 

deseada. Con estas funciones avanzadas se puede hacer lo siguiente: 

 Guardar la configuración del software de los dispositivos 3Com en archivos de 

respaldo. 

 Restaurar la configuración guardada en el archivo de respaldo, y aplicar a 

cualquier dispositivo del mismo tipo. 

 Definir una línea base de configuración. 

 Redefinir la configuración marcada como línea base. 

 Restaurar una configuración de línea base. 

 Comparar configuraciones. 
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3.1.3.1. Copia de seguridad 

La función de copia de respaldo está designada para ayudar en el 

almacenamiento de la configuración de los dispositivos 3Com, asociando cada 

copia de respaldo en un archivo individual. 

Para realizar la copia de seguridad de la configuración de un dispositivo se debe 

ejecutar el asistente desde el menú principal de la aplicación y ejecutar 

Device>Backup. 

El asistente muestra varios cuadros de diálogos durante el proceso de respaldo, 

que explican la brevemente la actividad a realizarse, concentrándose en tres 

pasos definidos: 

 Escoger los dispositivos a respaldar. En este paso debe seleccionar cuales 

dispositivos 3Com presentes en la red, serán los que deben ser respaldados. 

Puede seleccionar entre respaldar todos los dispositivos existentes en la red, 

solo un tipo de dispositivo o personalizar el respaldo. 

Gráfico No. 2-13: Selección del tipo de respaldo 

 

 Especificar nombre y descripción. Antes de realizar el respaldo, es 

necesario especificar el nombre y descripción que identificará la copia. 

También se puede especificar que el respaldo sea una configuración de línea 

base. 
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Línea base, es una configuración predeterminada de un switch que se guarda 

en el software interno del dispositivo, y puede ser restaurado en cualquier 

momento, o después de haber realizado un cambio no deseado en la 

configuración. 

Gráfico No. 2-14: Ingresar nombre y comentario en archivos de respaldo 

 

 Confirmar. En este paso debe configurar si la copia de respaldo se ejecutará 

inmediatamente o más tarde seleccionando mes, fecha y hora. Finalmente el 

asistente presenta un resumen de la configuración de respaldo y culmina el 

proceso. 

Gráfico No. 2-15: Configurar fecha de creación de respaldo 
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Cuando finaliza el proceso de copia de respaldo, lanza un evento y una alerta 

indicando sí el proceso ha concluido satisfactoriamente o ha fallado. 

3.1.3.2. Restauración 

La función de restauración permite aplicar una configuración previamente 

guardada que coincida con el tipo de dispositivo físico. Puede restaurar 

configuraciones de todos los dispositivos, dispositivos de un solo tipo o 

dispositivos seleccionados. El asistente de restauración es ejecutado desde el 

menú principal Device>Restore. 

El proceso de restauración se realiza siguiendo los pasos descritos a 

continuación: 

 Tipo de restauración. Para iniciar el proceso, debe seleccionar el tipo de 

restauración que desea realizar; línea base de todos los dispositivos, línea 

base de un tipo de dispositivo, línea base de un dispositivo en particular o 

restaurar un solo dispositivo. 

Gráfico No. 2-16: Restauración de dispositivo 

 

 Especificar dispositivos. El siguiente cuadro de diálogo muestra en caso de 

que existan configuraciones de línea base, caso contrario solo mostrará la 
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restauración para el dispositivo seleccionado. De igual forma, cuando finaliza 

la restauración, lanza un evento con alerta mostrando el resultado del proceso. 

3.1.4. Administración de dispositivos 3com 

3ComND también puede administrar dispositivos 3Com soportados desde la 

estación de trabajo donde está ejecutándose la aplicación, en forma remota hasta 

acceder al dispositivo utilizando herramientas como: Web management y Telnet 

mamagement. Además permite registrar vía internet los dispositivos 3Com 

adquiridos para posteriormente acceder a la garantía que ofrece la empresa. 

 Web Management. Muchos dispositivos 3Com proporcionan una interface 

Web que permite administrar un dispositivo único o una pila de dispositivos de 

una sola vez. El navegador de internet es usado para desplegar esta interface. 

Para acceder es necesario tener un usuario y contraseña. 

 Telnet Management. Para que la conexión funcione, como en todos los 

servicios de Internet, la máquina a la que se acceda debe tener un programa 

especial que reciba y gestione las conexiones. El puerto que se utiliza 

generalmente es el 23. 

Varios dispositivos 3Com proporcionan una interface de administración de 

Telnet que permite administrar un único o conjunto de dispositivos de una sola 

vez.  

3.1.4.1. Tipos de dispositivos administrados 

Tanto 3ComNS y 3ComND soportan la administración de dispositivos compatibles 

y ofrece varios servicios:  

 3Com Wireless switch Manager. Es el elemento que permite administrar la 

familia de 3Com Wireless soportando los modelos: WX2200, WX1200 y 

WXR100.g 
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 3Com Device Manager. La versión 4.o o superior permite administrar y realizar 

mantenimiento de nuevos Routers 3Com y switches Ethernet en la red. 

 3Com switch Manager. Permite administrar switches 7700. 

 3Com Router Manager. Administra dispositivos de la familia Routers 3Com. 

 3Com Device View. Este servicio permite ver y modificar la configuración de la 

mayoría de los switches y Routers 3Com. 

 Network Jack Configuration Manager. Proporciona administración para los 

Jacks de redes 3Com. 

Para acceder a estas funciones de administración en el menú principal de la 

aplicación seleccione Device Administration>[Seleccionar cualesquiera de las 

funciones disponibles]. 

Gráfico No. 2-17: Menú administración de dispositivos 

 

3.1.4.2. Registrar dispositivos para garantía 

A través de la red, se puede registrar dispositivos 3Com adquiridos, con la 

finalidad de aplicar la garantía y soporte total como reparación de software y 

hardware cuando se requerido. El registro del dispositivo solicita varios datos 

referentes al dispositivo y la empresa o compañía que adquirió el dispositivo. 
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Gráfico No. 2-18: Ventana de registro en línea 

 

2.4. PREGUNTAS MÁS FRECUENTES 

2.4.1. ¿SE PUEDEN ELIMINAR LOS ARCHIVOS DE RESPALDO (BACKUP 

FILES)? 

La aplicación no borra los archivos de respaldo existentes para un dispositivo, 

cuando son creados nuevos archivos de respaldo. Lo que ocasiona que la lista de 

archivos de respaldo se incrementa indefinidamente para un dispositivo. Sin 

embargo, se puede borrar manualmente los archivos de respaldo utilizando el 

explorador de Windows, de la siguiente manera: 

1. Abrir el explorador de Windows 

2. Entrar hasta el directorio que contiene los archivos de respaldo, generalmente 

se encuentra en: “C:\ Archivos de Programa \3Com\Network Supervisor". 

3. Seleccione y borre los archivos de respaldo que ya no desea mantenerlos. 

Los archivos de respaldo tienen una extensión .xml y tienen el siguiente formato:  

Gráfico No. 2-19: Formato de archivos de respaldo 
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CAPÍTULO III 

REQUERIMIENTOS Y LÍMITES 

3.1. REQUERIMIENTOS 

3.1.1. REQUERIMIENTOS DE HARDWARE 

3com Network Supervisor 6.0 y 3Com Network Director 3.0 requieren del 

siguiente hardware para operar correctamente: 

 PC IBM compatible 

 Procesador. Mínimo: 500 Mhz Pentium III; recomendado: 1Ghz Pentium IV. 

 Memoria RAM. Mínimo: 512 Mb; recomendado 1Gb o más. 

 Espacio libre en disco. Mínimo: 500 Mb; recomendado: 1 Gb. 

 Pantalla. Mínimo: 1024 x 768 con capacidad de gráfico con 64k colores. 

 Tarjeta de red, necesario. 

 CD-ROM o conexión a Internet. 

CD-ROM es requerido si 3ComNS es instalado desde un CD, mientras que la 

conexión a Internet es utilizado en caso de que sea descargado desde la red. 

3.1.2. SISTEMAS OPERATIVOS COMPATIBLES 

3ComNS es soportado en los siguientes sistemas operativos: 

 Windows 2000 profesional 

 Windows XP profesional. 

 Windows Vista 
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 Windows Server 2008 

3.1.3. SOFTWARE IMPORTANTE 

Para operar 3ComNS no es necesario software adicional, pero algunas funciones 

adicionales disponibles se pueden utilizar si se encuentra instalado el software 

apropiado: 

 Adobe Acrobat Reader. Es requerido para acceder a la documentación del 

usuario proporcionado con el software Network Supervisor. 

 Para acceder a los reportes, actualizaciones y consultas en la red es necesario 

tener instalado cualquiera de los siguientes navegadores de Internet: Microsoft 

Internet Explorer 6 o superior; Netscape Navigator 7,72 o superior; Mozilla 

Firefox 1.5 o superior; Opera 9. 

3.2. LÍMITES Y PROTOCOLOS SOPORTADOS 

3.2.1. CANTIDAD DE DISPOSITIVOS 

3Com Network Supervisor puede administrar hasta 1.500 dispositivos y hasta 

1500 teléfonos IPs de 3Com. En versiones anteriores a la 6.0, con la instalación 

del Avanced Package (paquete avanzado) el software podía llegar a administrar 

hasta 2500 dispositivos o 4000 dispositivos si la red incluye teléfonos IP. 3Com 

Network Director 3.0 puede administrar hasta 5000 dispositivos, incluidos 

teléfonos IP. 

El proceso de descubrimiento automáticamente se detiene si excede el límite de 

dispositivos encontrados. Por lo tanto, redes de clase “A” no son soportados, 

porque son capaces de contener más de 65535 dispositivos. 
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3.2.2. PROTOCOLO DE RED 

3.2.2.1. Ethernet 

Ethernet es un estándar de redes de computadoras de área local con acceso al 

medio por contienda CSMA/CD; define las características de cableado y 

señalización de nivel físico y los formatos de tramas de datos del nivel de enlace 

de datos del modelo OSI. 

3.2.2.2. Internet Protocol (IP). 

3ComNS soporta únicamente IP de capa 3 del modelo OSI, utilizado como 

estándar de comunicación para enviar datos a través de la red. IP es un protocolo 

orientado a conexión, usado tanto por el origen como por el destino para la 

comunicación de datos a través de una red de paquetes conmutados. 

3.2.2.3. Protocolo SNMP.  

El Protocolo Simple de Administración de Red o SNMP es un protocolo de la capa 

de aplicación que facilita el intercambio de información de administración entre 

dispositivos de red. Es parte de la familia de protocolos TCP/IP. SNMP permite a 

los administradores supervisar el desempeño de la red, buscar y resolver sus 

problemas, y planear su crecimiento. 

Las versiones de SNMP más utilizadas son dos: SNMP versión 1 (SNMPv1) y 

SNMP versión 2 (SNMPv2). Ambas versiones tienen un número de características 

en común, pero SNMPv2 ofrece mejoras. SNMP en su última versión (SNMPv3) 

posee cambios significativos con relación a sus predecesores, sobre todo en 

aspectos de seguridad, sin embargo no ha sido mayoritariamente aceptado en la 

industria. 
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3.2.3. DISPOSITIVOS SOPORTADOS 

El software en estudio, tiene total compatibilidad con la mayoría de dispositivos 

3Com que utilizan los protocolos anteriormente señalados, además soporta una 

variedad de dispositivos que no son 3Com. 

A Continuación se muestra una lista de dispositivos 3Com y no 3Com con la 

mínima versión de software soportados por Network Supervisor: 

Tabla No. 10: Dispositivos soportados por 3Com Network Supervisor 

Dispositivo Versión mínima 

3Com OfficeConnect switch 140M 1.00 1.00 

3Com OfficeConnect Managed Gigabit PoE switch ALL Todos 

switch 610 1.08 

switch 630 1.08 

3Com SuperStack II switch 1000 1.01 

3Com SuperStack II Desktop switch 2.10 

switch 1100 Family 1.02 

3Com Linkswitch 2200 8.1.1 

Baseline switch Family Todos 

3Com SuperStack II switch 3000 2.10 

switch 32xx Family 1.0 

3Com SuperStack II Layer 3 Module 1.00 

3Com SuperStack II switch 3300 1.02 

3Com SuperStack II switch 3300 FX 2.00 

3Com SuperStack II switch 3300 XM 2.30 

3Com SuperStack II switch 3300 MM / SM / TM 2.50 

3Com SuperStack II switch 3300 XM (3C16985) 2.50 

3Com SuperStack 3 switch 3300 2.60 

3Com SuperStack 3 switch 3300 MM / SM / TM /MM 2.50 

3Com SuperStack II IP switch 3800 1.2.14 

SuperStack 3 switch 38xx Family 1.0 

3Com SuperStack II 3900 2.0 

switch 4005 0.0 

switch 40x0 Family 2.5 

3Com switch 4007 2.0 

switch 4228G Family 2.0 

switch 4200 Family 1.0 

switch 4200G Family Todos 
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Dispositivo Versión mínima 

SuperStack 3 switch 4300 1.0 

SuperStack 3 switch 4400 (24 Port) 1.0 

SuperStack 3 switch 4400 (48 Port) 2.0 

SuperStack 3 switch 4400 PWR 3.12 

SuperStack 3 switch 4400 SE 2.1 

SuperStack 3 switch 4400 FX 3.2 

switch 4210 family Todos 

switch 4500 3.01 

switch 4500G Family 5.1.0 

switch 4800G Family Todos 

switch 49xx Family 1.0 

switch 5500-SI Family Todos 

switch 5500-EI Family Todos 

switch 5500G-EI Family 3.01 

3Com Secure switch 6200 Todos 

switch 7700 1.00 

switch 7750 1.0 

switch 7900E family Todos 

3Com switch 8800 Family 3.0 

3Com SuperStack II switch 9000 1.0.9 

3Com SuperStack II switch 9100 6.0 

3Com SuperStack II 9300 2.0 

3Com Network Jack NJ200 1.0 

3Com IntelliJack switch NJ205 1.1 

3Com IntelliJack switch NJ220 2.0 

3Com IntelliJack switch NJ225 2.5 

3Com IntelliJack switch NJ2xx FX Family 2.4.100 

3Com Wireless LAN switch WXR100 Todos 

3Com Wireless LAN switch WX1200 3.0.3 

3Com Wireless LAN Controller WX4400 3.0.0 

3Com Wireless LAN Controller WX2200 Todos 

3Com AirProtect Wireless Engine IPS 6100 5.5.156 

3Com Unified switch Todos 

Access Point 3150 Todos 

Access Point 3850 Todos 

Access Point 7250 2.0 

Access Point 7760 Todos 

Access Point 8000 Todos 

Access Point 8200 2.0 

Access Point 8250 2.1 
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Dispositivo Versión mínima 

Access Point 8500 2.2 

Access Point 8700 2.3 

Access Point 8750 2.4 

Access Point 8760 Todos 

3Com Wireless Workgroup Bridge 1.1.21 

Building To Building Bridge Todos 

3Com OfficeConnect Wireless 108Mbps 11g PoE Access Point Todos 

Office Connect Firewall wireless router Todos 

3Com Router 301x Family 1.10 

3Com Router 303x Family 1.0 

3Com Router 3036 Todos 

3Com Router 3040 Todos 

3Com Router 3041 Todos 

3Com Router 5009 1.10 

3Com Router 5231 1.10 

3Com Router 5640 1.10 

3Com Router 5680 1.10 

3Com Router 5012 2.01 

3Com Router 5232 2.01 

3Com Router 5642 2.01 

3Com Router 5682 2.01 

3Com Router 6040 1.0 

3Com Router 6080 1.0 

3Com MSR Router Family Todos 

3Com SuperStack II Remote Access System 1500 1.0.27 

3Com SuperStack 3 Webcache Family 1.0 

3Com SuperStack 3 Server Load Balancer Todos 

3Com Office Connect VPN Firewall SNMP 

OfficeConnect Wireless 108Mbps Cable/DSL Router 1.2.1.0 

TippingPoint IPS Family Todos 

TippingPoint X505 Todos 

Tipping Point X506 Todos 

3Com X506 Todos 

3Com X5 Todos 

3Com NBX Call Processors Todos 

3Com VCX 7.1 

Eaton PowerWare RPS family Todos 

Siemens C10, C100, C1000 wireless switches Todos 

Cisco 3750 switch Todos 

Cisco 4500 switch Todos 

Cisco 6500 switch Todos 
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Para permitir la identificación y topología de las redes por medio de 3Com 

Network Supervisor se debe habilitar SNMP que en algunos dispositivos viene 

deshabilitado por defecto, como son: switch 7700 family, switch 7750 family, 

switch 8800 family, switch 6200, 3Com Router 3xxx, 3Com Router 5xxx y 3Com 

Router 60x0. 

3Com Network Director soporta muchos dispositivos adicionales, que pueden ser 

configurados para ejecutar las funciones avanzadas disponibles. 

3.2.4. SEGURIDAD 

Hoy en día todos dependemos de la información que radica y generamos en 

nuestras computadoras; estos objetos ya no se encuentran aislados como en los 

80´s y principios de los 90´s; si no por el contrario, hoy dependemos de una 

conexión física para podernos comunicar, el avance que se ha tenido con las 

redes nos ha permitido solucionar problemas y hacer provecho de sistemas que 

nos ayudan a manipular la información. 

Empresas, organizaciones y cualquier persona que utiliza  una computadora 

envía y recibe correos electrónicos, comparte información de manera local o a 

nivel mundial, realiza transacciones, ofrece servicios y encuentra soluciones a sus 

requerimientos. Es así que la información se vuelve algo muy preciado tanto para 

los usuarios como para los Hackers. Es por eso que tenemos que tener una serie 

de precauciones para evitar que alguien no deseado busque en nuestra 

información y seamos presa fácil de extorsiones, fraudes y pérdidas irreparables. 

Por tales razones, el empleo del software de monitoreo vulnera de cierta forma la 

seguridad en la estación de trabajo donde está corriendo el programa ya que 

3ComNS solamente puede monitorear dispositivos mientras estos estén activos 

(encendidos), y por su puesto el computador donde esta ejecutándose el software 

también debe estar encendida; mantener encendido el computador sin ningún 

tipio de contraseña aumenta la probabilidad de que exista algún tipo de ataque a 

la información existen en el computador cuando el administrador de red abandona 

el área de trabajo. En estos casos, una buena recomendación es activar el 



   

93 

 

protector de pantalla de Windows con contraseña, para evitar que personas no 

autorizadas accedan al software mientras está monitoreando. 
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CAPÍTULO V 

RESULTADOS DEL SISTEMA 

4.1. INSTALACIÓN DE 3COM NETWORK SUPERVISOR 

El instalador se puede descargar desde la página web de la empresa 3Com 

www.3com.com y probar el software con todas sus funcionalidades durante 60 

días, de este luego es necesario comprar una licencia para continuar utilizando la 

aplicación. El costo aproximado del software 3Com Network Director para la 

compra en línea oscila entre 1.600 dólares y 2.000 dependiendo de la tienda 

donde se compre. 

La instalación de 3Com Network Supervisor 6.0 y 3Com Network Director 3.0 es 

necesario considerar el sistema operativo soportado, caso contrario no se podrá 

instalar la aplicación. 

4.1.1. PASOS PARA REALIZAR LA INSTALACIÓN 

Para realizar la instalación del software se debe ejecutar los siguientes pasos: 

 Ejecutar el instalador desde el explorador de Windows. 

Gráfico No. 4-1: Instalador de 3Com Network Supervisor 

 

http://www.3com.com/
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 Seguir las instrucciones presentes en las ventanas y cuadros de diálogo. 

Gráfico No. 4-2: Proceso de instalación 

 

 Al finalizar la instalación, se presenta un cuadro de diálogo donde tiene que 

ingresar el código de activación en caso de que se haya adquirido una 

licencia; de lo contrario solamente presionamos el botón OK para probar la 

aplicación gratuitamente durante 60 días.   

Gráfico No. 4-3: Cuadro de diálogo de Activación 
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 Por último, la aplicación realizará el primer descubrimiento de la red, donde se 

ejecuta el asistente de descubrimiento. 

4.2. PRESENTACIÓN DE RESULTADOS 

Los resultados del sistema se obtuvieron desde una práctica realizada en el 

Laboratorio de Computación No. 1, de la Escuela Politécnica del Ejército sede 

Latacunga (ESPE-L). 

4.2.1. PRÁCTICA DE LAS FUNCIONES BÁSICAS DEL 3COM NETWORK 

SUPERVISOR 

4.1.1.1 Proceso de descubrimiento de red 

Una vez ejecutada la aplicación por primera vez, se presenta un cuadro de 

diálogo donde inicia el proceso de descubrimiento de red.  

Gráfico No. 4-4: Práctica: Proceso de descubrimiento de red 

 

En esta pantalla se ingresa la red que desea descubrir, en este caso la dirección 

IP de la subred 10.2.4.0 que pertenece a la ESPE-L, continuando con la 

configuración del proceso de descubrimiento de red, debe confirmar algunas 

opciones como: protocolo de conexión, existencia de dispositivos telefónicos, etc.  
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Terminado el proceso de descubrimiento de red, la aplicación presenta un 

resumen del proceso, donde muestra una lista de dispositivos encontrados con 

sus respectivos nombres, direcciones IPs y el tipo de dispositivo. 

Gráfico No. 4-5: Resumen del descubrimiento de red 

 

En el caso expuesto, la aplicación muestra un problema de descubrimiento que se 

explica a continuación. 

El reporte de descubrimiento muestra un problema con el dispositivo con la 

dirección IP 10.2.1.9, lo que significa que 3ComNS no dispone de suficiente 

información para determinar el tipo de dispositivo o también puede existir un 

conflicto de conexión. 
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Gráfico No. 4-6: Reporte de descubrimiento 

 

Inmediatamente la aplicación dibuja el mapa de red; con la topología descubierta, 

mostrando todos los dispositivos y conexiones encontrados. En el ejemplo, se 

muestra el switch 24220G que pertenece al Laboratorio de Computación No. 1, 

donde están colgados 6 estaciones de trabajo, incluida la máquina donde está 

instalada la aplicación (encerrado en un triángulo); también muestra 14 estaciones 

de trabajo colgados a una nube de Ethernet que la aplicación no ha podido 

determinar la topología. 
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Gráfico No. 4-7: Topología de red descubierta por Network Supervisor 

 

4.1.1.2 Monitoreo de dispositivos 

Para iniciar el monitoreo de la red se debe seleccionar el dispositivo, conexión o 

toda la sub red, dar clic derecho y ejecutar Start Monitoring. 

En la práctica realizada, se inicio el monitoreo de algunas estaciones de trabajo y 

del switch, mostrando las máquinas en diferentes colores de acuerdo al estado 

actual de los servicios.   
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Gráfico No. 4-8: Estado de monitoreo de dispositivos 

 

 El computador con dirección IP 10.2.4.116 de color rojo significa que tiene un 

evento severo que no ha sido resuelto.  

Ejecutando la ventana Live Graphs para el dispositivo actual,  muestra un 

problema con el servicio PING. 

Gráfico No. 4-9: Monitoreo del servicio IP Ping caído 

 

Ejecutando la opción More Details (Más de talles), se puede ver las posibles 

causas y soluciones al problema. En resumen, indica que el dispositivo no 

responde porque puede estar desconectado, averiada la tarjeta de red, 

dispositivo apagado, etc. 
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Gráfico No. 4-10: Causas y soluciones error IP ping 

 

En el ejercicio expuesto, a propósito se desconectó el cable de red para 

comprobar la efectividad del programa. 

 El computador con dirección IP 10.2.4.114 de color amarillo significa que tiene 

un evento grave sin resolver.  

En este caso se ha comprobado que todos los dispositivos de color amarillo no 

están respondiendo al servicio de mensajería POP3 Service. De la misma 

manera, dando clic derecho en More Datails muestra las posibles causas y 

sugerencia para resolver el evento.  

Gráfico No. 4-11: Monitor de servicio POP3 no responde 
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 El computador con dirección IP 10.2.4.86 de color blanco significa que el 

dispositivo no está siendo monitoreado.  

4.1.1.3 Eventos y alertas 

Los eventos son acontecimientos que han ocurrido en la aplicación o la red 

durante el monitoreo de redes. En el ejemplo, se puede apreciar que en la 

ventana de eventos están registradas todas las actividades realizadas y ocurridas 

en la aplicación. 

Gráfico No. 4-12: Ventana de eventos 

 

En el gráfico anterior se muestra en detalle todos los eventos sucedidos en la 

aplicación, indicando en diferentes colores de acuerdo a la severidad del evento; 

por ejemplo, el color rojo indica que el dispositivo 10.2.4.116, a las 12:23 PM del 4 

de septiembre del 2009, el dispositivo no está respondiendo. 

Para configurar una alerta se debe seleccionar un dispositivo o un evento, en 

nuestro ejemplo se va a configurar un evento en la estación de trabajo 10.2.4.116 

para que se active la alerta tipo Popup (mensaje en pantalla) cuando pierda la 

conexión, es decir cuando no responda al servicio IP PING. 
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Gráfico No. 4-13: Configuración de alertas 

 

Después de unos segundos que se desconectó el cable de red del equipo 

indicado, la aplicación lanzó una, alerta mostrando los detalles el siguiente 

cuadro.  

Gráfico No. 4-14: Alerta Popup 
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4.2.1. PRÁCTICA DE LAS FUNCIONES AVANZADAS DEL 3COM NETWORK 

DIRECTOR 

4.2.1.1 Configuración de dispositivos  

La configuración es posible realizar en dispositivos compatibles como switches, 

puertos, Access points, etc. En este ejemplo vamos a crear una plantilla de 

configuración para switches. 

 Ingresamos a la ventana de configuración desde el menú principal 

Device>Configure>switch Devices. 

 Una vez en la ventana, se procede a realizar la configuración de la plantilla, 

ingresando en cada panel existente: Seguridad, Administración, General, etc. 

Gráfico No. 4-15: Configuración de switches 

 

NOTA: Para realizar la configuración de plantillas es importante tener un vasto 

conocimiento en la configuración de dispositivos switches, de lo contrario podría 

ocasionar cambios no deseados en la red. 
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 Finalmente, se procede a guardar la plantilla dando clic en el botón Save As… 

Las plantillas tienen extensiones .cfg 

Gráfico No. 4-16: Guardar configuración 

 

4.2.1.2 Copia de seguridad, restauración e instalación dispositivos 

Las copias de seguridad sirven para guardar la configuración de los dispositivos, 

es este caso del switchS4228G presente en el mapa de red descubierto. 

Gráfico No. 4-17: Detalles de copia de respaldo 
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Seleccionado las opciones de copia de respaldo se coloca el nombre en el archivo 

y un comentario al respecto. Luego se ejecuta la copia de respaldo 

inmediatamente o en una fecha señalada en la opción Schedule.  

Finalmente, presenta un reporte con los detalles de la copia de respaldo, en 

nuestro ejemplo no se pudo realizar, porque es necesario tener instalado telnet 

para acceder al switch. 

Gráfico No. 4-18: Reporte de error en copia de respaldo 

 

3ComND también puede recuperar copias de respaldo, o instalar la configuración 

de un dispositivo existente a otro dispositivo del mismo tipo. Para hacer esto en el 

menú principal accedemos a Restore y Setup. En el presente ejemplo, se intenta 

instalar la configuración de switchS4228G en otro dispositivo, sin embargo es el 

único dispositivo existente en el mapa de red, por lo cual no es posible completar 

la instalación del dispositivo. 
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Gráfico No. 4-19: Instalación de switch 

 

4.2.1.3 Administración de dispositivos 

Ésta función permite administrar dispositivos 3Com compatibles, y se puede 

realizar tanto el 3Com Network Director 3.0 y 3Com Network Supervisor 6.0.  

Para acceder a estas funciones se lo realiza desde la barra de herramientas 

Device>Administration>3Com Device Manager. 

En nuestro ejemplo, se accede al dispositivo switchS4228G, donde permite 

realizar la configuración total del dispositivo. 
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Gráfico No. 4-20: Administración de switches 

 

Nota: Para configurar un switch es necesario tener conocimientos avanzados, de 

no ser así podría ocasionar problemas en las conexiones de la red.   
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CAPÍTULO V 

CONCLUSIONES Y RECOMENDACIONES 

5.1. CONCLUSIONES 

 3Com Nerwork Supervisor 6.0 y Nerwork Director 3.0, por sus características 

y funciones avanzadas, representan paquetes informáticos muy potentes, que 

proporcionan gran ayuda en la administración de redes. 

 Las aplicaciones estudiadas, ofrecen herramientas importantes de monitoreo 

de redes, proporcionando suficiente información de la subred y dispositivos 

conectados dentro de ella; para que el administrador de la red pueda tomar 

decisiones concretas en caso que exista un problema en la red. 

 Una desventaja de estas dos aplicaciones es la falta de soporte para ciertos 

dispositivos distintos a la marca 3Com; ya que en una red siempre existen 

varios tipos de dispositivos de diferentes casas comerciales; entonces el 

empleo de este software en redes con dispositivos de otras marcas podría 

ocasionar resultados inesperados. 

 Las herramientas y funciones presentes en Network Supervisor y Network 

Director están orientadas especialmente a la administración de switches, 

routers, access point, etc. de la marca 3Com, lo que reduce 

considerablemente la fiabilidad de la aplicación, frente a otras aplicaciones de 

monitoreo como WhatsUp. 
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5.2. RECOMENDACIONES 

 Cuando se está operando 3Com Network Supervisor, siempre es necesario 

realizar un procedo de redescubrimiento de la red, porque existen dispositivos 

y conexiones que en primera instancia no son descubiertos. 

 Los estudiantes y profesionales de la computación realicen pruebas de 

rendimiento y eficiencia de estas dos aplicaciones; para confirmar o denegar 

las afirmaciones realizadas en el presente trabajo de grado.  

 Una vez analizadas las ventajas y desventajas de la aplicación, la Dirección 

de Sistemas  de información y Comunicaciones del Ejército Ecuatoriano 

(DISICOM) debería testear el software durante el período de prueba para 

estudiar los resultados obtenidos y determinar si realmente es una 

herramienta útil en la administración de la red del Ejército Ecuatoriano. 
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